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1. Γενικά 
 
Το σεμινάριο αφορά την αξιοποίηση του λογισμικού Adobe Premier Pro CS3καθώς 
και του διαδικτύου στην τεχνική και επαγγελματική εκπαίδευση, και συγκεκριμένα, 
στη διδασκαλία του μαθήματος «ΠΑΡΑΓΩΓΗ ΚΑΙ ΕΠΕΞΕΡΓΑΣΙΑ ΣΗΜΑΤΟΣ» της 
ειδικότητας «Ηλεκτρονικών Συστημάτων Επικοινωνιών» του τομέα Ηλεκτρονικής.  
Βασίζεται στην πραγματοποίηση ενός επιμορφωτικού σεναρίου με θέμα την 
συνάρμοση και επεξεργασία εικόνας, καθώς και την δημιουργία οπτικών και 
ηχητικών εφέ και την πρόσθεση τίτλων. Το αντικείμενο αυτό ενσωματώνεται στις 
διδακτικές ενότητες του βιβλίου «Παραγωγή και Επεξεργασία σήματος» που 
διδάσκεται στην Γ’ τάξη των ΕΠΑΛ, χρησιμοποιώντας και ασκήσεις του βιβλίου. 
Οι επιμορφούμενοι χωρίζονται σε μικρές ομάδες, κάθε μία από τις οποίες 
αντιπροσωπεύει τα μέλη της υποτιθέμενης εταιρίας. Ο επιμορφωτής αναλαμβάνει 
ρόλο συντονιστή του έργου. 
Οι πρώτες δραστηριότητες αφορούν τη γνωριμία με το λογισμικό και τις βασικές 
αρχές λειτουργίας του καθώς επίσης και την οργάνωση της εργασίας στον 
υπολογιστή.  
Οι επιμορφούμενοι καλούνται να μάθουν τις δυνατότητες και τον χειρισμό του 
λογισμικού Adobe Premier Pro CS3 καθώς και να δημιουργήσουν μία δική τους 
ταινία με την βοήθεια των δυνατοτήτων του Adobe Premier Pro CS3.   
Στις επόμενες ενότητες δίνεται η δυνατότητα να κάνουν απ’ ευθείας εγγραφή από 
την κάμερα στον υπολογιστή και να με την βοήθεια του προγράμματος να 
εισάγουν ήχο και τίτλους στην ταινία. Επίσης θα προσθέσουν διάφορα εφέ σε 
αυτήν. 
Στις τελευταίες ενότητες παρουσιάζεται ολοκληρωμένη η εργασία και εγγράφεται 
σε ένα DVD. Γίνεται αναζήτηση στο διαδίκτυο για σχετικά θέματα και πηγές που 
αφορούν την επεξεργασία εικόνας καθώς και τη χρήση του Adobe Premier Pro CS3 
για το σκοπό αυτό. 
  

2. Ένταξη Σεμιναρίου στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ώρες: 27 

 
3. Περιγραφή επιμορφωτικού σεναρίου 
 
Οι επιμορφούμενοι χωρίζονται σε ομάδες των τριών ατόμων και ο καθένας 
αναλαμβάνει ένα συγκεκριμένο ρόλο ανάλογα με την εξοικείωσή του στη χρήση 
του υπολογιστή και του λειτουργικού συστήματος WINDOWS, του δικτύου και του 
λογισμικού Adobe Premier Pro CS3. Στην συνέχεια όμως αφού και οι 
υπόλοιποι εξοικειωθούν με τα παραπάνω λειτουργικά συστήματα, 
αλλάζουν ρόλους σε κάθε δραστηριότητα. Στις ομάδες δίνονται σε έντυπη 
μορφή οι οδηγίες για την διαμόρφωση του τελικού προϊόντος και σε ηλεκτρονική 
μορφή κάποιες ταινίες μικρού μήκους (video clips).  
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Το σενάριο έχει σχεδιαστεί με τέτοιο τρόπο ώστε να κινητοποιεί όλους τους 
επιμορφούμενους να αντιμετωπίσουν όλα τα απαιτούμενα στάδια, προκειμένου να 
καταλήξουν στην διαμόρφωση του τελικού προϊόντος που θα είναι η δημιουργία 
μίας ταινίας με τίτλους, υπότιτλους και διάφορα οπτικά και ακουστικά εφέ. 
Κατανέμονται ρόλοι ανάλογα με το δυναμικό του κάθε επιμορφούμενου για να 
αποσαφηνίζονται έννοιες και να υιοθετούνται πρακτικές μεταξύ των μελών των 
ομάδων, αλλά και μεταξύ των ομάδων και του επιμορφωτή, ώστε οι 
επιμορφούμενοι να γίνονται ικανοί να λύνουν τα προβλήματα που παρουσιάζονται. 

 
Τα μέλη της ομάδας καλούνται να ενώσουν μια σειρά από μικρές ταινίες που τους 
δίνονται ή έχουν κάνει μόνοι τους, να παρέμβουν σε αυτές προσθέτοντας ήχο και 
τίτλους και να συνθέσουν όλα αυτά για την παρουσίαση μιας ολοκληρωμένης 
ταινίας.  
 

Η επιλογή του θέματος του επιμορφωτικού σεναρίου έχει σαν σκοπό τη σύνδεση 
του μαθήματος «Παραγωγή και Επεξεργασία σήματος» με την επαγγελματική 
πράξη διότι το αντικείμενο του μαθήματος αφορά θέματα που πλέον χειρίζονται 
ευκολότερα και με μεγαλύτερη ακρίβεια με τη βοήθεια Η/Υ και κατάλληλων 
λογισμικών. 

 

Η θεωρητική στήριξη του σεναρίου βασίζεται κυρίως στο πλαίσιο της 
εμπλαισιωμένης μάθησης (situated learning), μέσω της ανάπτυξης κοινοτήτων 
πρακτικής (community of practice), οι οποίες δημιουργούν τις προϋποθέσεις για 
ένα αυθεντικό πλαίσιο μάθησης, ενώ ταυτόχρονα μπορούν να αξιοποιούν την 
εμπειρία των εκπαιδευομένων (αρχαρίων και ειδικών), όταν αυτοί κινούνται από 
την περιφέρεια προς το κέντρο δηλ. το μαθησιακό στόχο (legitimate peripheral 
participation). 

 

4. ∆ιδακτικοί Στόχοι 
 

Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας του σεναρίου ο 
επιμορφούμενος αναμένεται: 
 Να εξοικειωθεί με την ηλεκτρονική συνάρμοση εικόνας η οποία είναι εντελώς 
διαφορετική από αυτή του εργαστηρίου, ο οποίος είναι ογκώδης και ακριβός . 

 Να καταλάβει την φιλοσοφία του λογισμικού και να γνωρίσει απλές και 
σύνθετες λειτουργίες του Adobe Premier Pro CS3. 

 Να γνωρίσει τις εντολές και τα εργαλεία του Adobe Premier Pro CS3 που πρέπει 
να χρησιμοποιήσει για να γίνει η ηλεκτρονική συνάρμοση μιας εικόνας. 

 Να επιλέγει τον αποτελεσματικότερο τρόπο γι’ αυτό. 
 Να δημιουργεί την δική του ταινία. 
 Να αναζητά, να επεξεργάζεται και να αποστέλλει ηλεκτρονικά αρχεία. 
 Να συνεργάζεται με άλλους για τη δημιουργία πολύπλοκων παρεμβάσεων στην 
διαμόρφωση μιας ταινίας. 

 Να εκμεταλλεύεται τη δυνατότητα που δίνει το διαδίκτυο στην πρόσβαση σε 
θέματα ειδικού ενδιαφέροντος και την συνεχή και άμεση ενημέρωση. 

 

5. Απαραίτητοι Τεχνολογικοί Πόροι 
 
 Εργαστηριακοί χώροι 
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Το εργαστήριο πληροφορικής του σχολείου  
 ∆ιαδικτυακή υποδομή 

Τοπικό δίκτυο και σύνδεση στο Internet.  
 Υλικό (Hardware) 

Υπολογιστές, ένας server και μία κάμερα λήψης εικόνας. 
 Λογισμικά Εργαλεία (Software) 

Tο λογισμικό Adobe Premier Pro CS3, ένας browser (π.χ. Internet Explorer) 
και άλλες εφαρμογές όπως Acrobat Reader, Word. 

 

6. Αναλυτική Περιγραφή ∆ραστηριοτήτων 
 
Το εκπαιδευτικό σεμινάριο αποτελείται από εννέα δραστηριότητες. Το θέμα και η 
διάρκεια κάθε μαθήματος παρουσιάζονται στον παρακάτω πίνακα. Το πρώτο 
τρίωρο είναι εισαγωγικό και αφορά στις δυνατότητες, τις λειτουργίες και γενικά τη 
φιλοσοφία του λογισμικού Adobe Premier Pro CS3. Οι επόμενες δραστηριότητες 
αποτελούν το εκπαιδευτικό σενάριο. Εκτενέστερη αναφορά στην περιγραφή και 
στους στόχους των δραστηριοτήτων γίνεται στο αναλυτικό πρόγραμμα του 
σεμιναρίου. 
 
Αρ. ∆ιάρκεια 

(ώρες) 
Θέμα 

1 3 ∆υνατότητες του Adobe Premier Pro CS3 – η φιλοσοφία του 

2 3 Ξενάγηση στο περιβάλλον του Adobe Premier Pro CS3 

3 3 ∆ημιουργία νέας ταινίας - Εισαγωγή δεδομένων 

4 3 Προσθήκη εφέ στην εναλλαγή των πλάνων 

5 3 Προσθήκη εφέ σε εικόνες και βίντεο 

6 3 ∆ημιουργία τίτλων 

7 3 Επεξεργασία ήχου 

8 3 Επεξεργασία έτοιμου βίντεο 

9 3 Μεταφορά της ταινίας σε μέσο αναπαραγωγής 

 
Κάθε δραστηριότητα του επιμορφωτικού σεναρίου πραγματοποιείται ύστερα από 
την ολοκλήρωση της αμέσως προηγούμενης.  
 

Θα δοθούν σε ηλεκτρονική μορφή: α) πίνακες με τις εργαλειοθήκες του 
λογισμικού (αρχείο PDF ή WORD) β) ταινίες μικρού μήκους (video clips).    

 

7. Περιγραφή ρόλων συμμετεχόντων 
 
Στην πραγματοποίηση των δραστηριοτήτων οι επιμορφούμενοι έχουν 
συγκεκριμένους ρόλους: 
 
Ρόλος επιμορφούμενου 
Οι επιμορφούμενοι χωρίζονται σε ομάδες των τριών ατόμων. Όλοι σχεδιάζουν και 
εκτελούν τις εργασίες και δραστηριότητες κάθε ενότητας του σεμιναρίου. Στα 
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πλαίσια της ομάδας, είναι δυνατό κάθε επιμορφούμενος να σχεδιάσει τμήμα του 
σχεδίου, ύστερα από συνεννόηση με την ομάδα του. Τέλος παραδίδει την εργασία 
του στον εκπρόσωπο της ομάδας του είτε ηλεκτρονικά μέσω email είτε 
αποθηκεύοντας την σε ένα κοινό φάκελο που έχουν δημιουργήσει στο τοπικό 
δίκτυο σαν ομάδα. 
 

Οι εκπαιδευτικές θεωρίες για τη συνεργατική μάθηση προτείνουν ότι μια ομάδα 
πρέπει να αποτελείται από μονό αριθμό μελών με καταλληλότερους τους αριθμούς 
τρία και πέντε. 

 
Ρόλος ομάδας επιμορφούμενων 
Κάθε ομάδα αντιπροσωπεύει το studio ενός τηλεοπτικού καναλιού από το οποίο 
ζητείται να δώσει μονταρισμένα πλάνα μιας εκπομπής.   
Για το τελικό προϊόν, η ομάδα πρέπει να εκτελέσει επιμέρους επεμβάσεις στην 
ταινία και να προσθέσει τίτλους και υπότιτλους αν χρειαστεί.  
Η κάθε ομάδα (ή ο επιμορφούμενος) αποθηκεύει τα προσωπικά της αρχεία σε δικό 
της φάκελο και τα  υποβάλλει ηλεκτρονικά μέσω email ή τα αντιγράφει σε ένα 
DVD και το παραδίδει. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν μία ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους. 
 
Επιμορφούμενος  Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Κατά τη διαδικασία της ηλεκτρονικής συνάρμοσης εικόνας, είναι υπεύθυνος για την 
σωστή και ακριβή εκτέλεση των παρεμβάσεων της ομάδας. Αναλαμβάνει επίσης να 
βοηθήσει τα άλλα μέλη της ομάδας αν έχουν δυσκολίες στην ηλεκτρονική 
συνάρμοση.  
 

Ο επιμορφούμενος Α, έχει αυξημένες αρμοδιότητες σε σχέση με τα υπόλοιπα μέλη, 
ώστε να μπορεί να δώσει λύσεις σε τυχόν προβλήματα που προκύπτουν μέσα στην 
ομάδα. Επίσης συντονίζει συζήτηση μέσα στην ομάδα, για να εξασφαλίσει την 
ποιότητα της εργασίας. Στην πορεία βέβαια όλοι οι επιμορφούμενοι θα 
κληθούν να πάρουν την θέση αυτή καθώς όλοι πρέπει να περάσουν από 
όλες τις θέσεις.  

 
Επιμορφούμενος Β: 2ος Μελετητής  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του δικτύου 
και του internet. Αναλαμβάνει την ηλεκτρονική αποστολή της εργασίας της ομάδας 
στον επιμορφωτή μέσω e-mail καθώς και την εκτύπωση της. 
 
Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου 
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 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Αcrobat, Πρόγραμμα 
ηλεκτρονικού ταχυδρομείου (Outlook Express, Mozilla Thunderbird) 
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8. ∆ραστηριότητες 
 
∆ραστηριότητα 1η: 
∆υνατότητες του Adobe Premier Pro CS3 – η φιλοσοφία του 

 
α. Γενικά 
 
Η δραστηριότητα αφορά στην παρουσίαση του λογισμικού Adobe Premier Pro CS3 
και στη χρήση των βασικών εντολών ηλεκτρονικής συνάρμοσης και επεξεργασίας  
εικόνας 
 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ενότητες: ∆υνατότητες του Adobe Premier Pro CS3 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να γνωρίζει τις δυνατότητες του λογισμικού Adobe Premier Pro CS3 
 Να εξοικειωθεί με την εγκατάσταση του Adobe Premier Pro CS3. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 

 
Ρόλος ομάδας επιμορφούμενων 
Στην εισαγωγική αυτή δραστηριότητα γίνεται η γνωριμία των μελών των ομάδων 
μεταξύ τους. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
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Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
O επιμορφωτής παρουσιάζει στους επιμορφούμενους τα μέρη από τα οποία 
αποτελείται το Adobe Premier Pro CS3. αυτά είναι: 
 Το DVD «Adobe Premier Pro CS3» για την εγκατάσταση του λογισμικού . 
 Το CD «Adobe OnLocation CS3». 
 Το DVD «Adobe Encore CS3» 

 
ΕΙΚΟΝΑ 1 

 
Μετά την εγκατάσταση, τα προγράμματα που δημιουργούνται στον φάκελο του 
Adobe Premier, όπως φαίνεται στην εικόνα 1, είναι: 
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 Adobe Premier Pro CS3 
Είναι το κυρίως πρόγραμμα, μέσα από το οποίο γίνεται η ηλεκτρονική 
συνάρμοση της εικόνας και του ήχου για την παραλαβή του τελικού προϊόντος. 

 Adobe OnLocation CS3 
Έχει την δυνατότητα να γράφει στον υπολογιστή, απευθείας από την κάμερα, 
βίντεο σε μορφή SD και HD. Αυτό σας δίνει την δυνατότητα να αποφεύγετε τα 
προβλήματα και να βελτιώνετε την ποιότητα λήψης, με την βοήθεια των 
εργαλείων, όπως: 
 Εικονικό μόνιτορ αναφοράς 
 Μόνιτορ κυματομορφής 
 Vectorscope 
 Αναλυτής ηχητικού φάσματος (audio spectrum analyzer) 

 Adobe Encore CS3 
Έχει την δυνατότητα να δημιουργήσει ένα DVD στάνταρ ευκρίνειας (SD) ή 
υψηλής ευκρίνειας (HD), αξιοποιώντας την τεχνολογία Blu-ray. Μπορεί επίσης 
να δημιουργήσει DVD στάνταρ ευκρίνειας από δίσκους Blu-ray υψηλής 
ευκρίνειας. Επίσης δημιουργεί ένα έργο με την μορφή Flash για την ευκολότερη 
προβολή τους στις ιστοσελίδες. 

 Adobe Bridge CS3 
∆ίνει τη δυνατότητα να χειριζόμαστε καλύτερα τις καθημερινές μας εργασίες. 
Με αυτό το λογισμικό μπορούμε να εντοπίσουμε τους φυσικούς μας πόρους. 
Εκτός αυτού μας δίνεται η δυνατότητα να βρίσκομαι τις πηγές μας και να τις 
τροποποιούμε. Μερικές από τις εργασίες που κάνει είναι: 
 Προσθέτει, διαγραφή και μετονομάζει αρχεία. 
 ∆ίνει πληροφορίες για τα αρχεία. 

 Adobe Device Central CS3 
Adobe Extendscript Toolkit 2 
 
Ξεκινώντας την παρουσίαση του Adobe Premier Pro CS3, θα αναφερθεί η τυπική 
ροή εργασίας για την δημιουργία ενός ψηφιακού βίντεο. Αυτή είναι: 

1. λήψη του βίντεο 
2. μεταφορά του βίντεο στον υπολογιστή 
3. μοντάρισμα του βίντεο 
4. προσθήκη διαφόρων εφέ εικόνας 
5. προσθήκη κειμένου 
6. προσθήκη ήχου (αυτό μπορεί να γίνει και στην αρχή) 
7. προσθήκη διαφόρων εφέ ήχου 
8. αποθήκευση της βιντεοταινίας στον υπολογιστή 

 
Ξεκινώντας το Adobe Premier Pro CS3 
Ξεκινώντας  το Adobe Premier Pro CS3 θα εμφανιστεί στον υπολογιστή, η εικόνα 
2. 
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ΕΙΚΟΝΑ 2 

Επιλέγοντας το εικονίδιο «New Project» θα ξεκινήσετε μία νέα βιντεοταινία, ενώ με 
το εικονίδιο «Open Project» θα ανοίξετε ένα αρχείο το οποίο είχατε αποθηκεύσει. 
Με το «New Project» θα εμφανιστεί το παράθυρο της εικόνας 3. 
 

 
ΕΙΚΟΝΑ 3 

 
Στο παράθυρο διαλόγου του «New Project» εμφανίζονται δύο επιλογές ρυθμίσεων: 
 Custom Settings 
 Load Preset 
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ΕΙΚΟΝΑ 4 

 
 
Το πάνελ Custom Settings 
Στο πάνελ αυτό ρυθμίζεται από μόνοι σας τα χαρακτηριστικά του ήχου και της 
εικόνας (εικόνα 4). Οι επιλογές του Custom Settings (ρυθμίσεις του 
πελάτη)χωρίζονται στις παρακάτω κατηγορίες: 
 General: περιέχει ρυθμίσεις που αναφέρονται στα χαρακτηριστικά των 

εικόνων, της κάμερας, του ήχου και της εγγραφής. Οι γενικές ρυθμίσεις είναι 
οι παρακάτω: 
 Editing Mode: αναφέρεται το σύστημα έκδοσης της ταινίας (π.χ. PAL, 

NTSC κλπ). 
 Timebase: αναφέρεται ο χρόνος εναλλαγής των εικόνων (frames). 
 Frame Size: αναφέρεται ο αριθμός των γραμμών και των κουκίδων ανά 

γραμμή και ο λεγόμενος των δύο πλευρών της εικόνας. 
 Frame Rate: αναφέρεται η συχνότητα εναλλαγής των εικόνων ανά 

δευτερόλεπτο. 
 Pixel Aspect Ratio: αναφέρεται ο τρόπος διαμόρφωσης των 

εικονοκυττάρων (pixels) 
 Fields:  HDV 720p. 
 Display Format: αναφέρεται ο τρόπος διαμόρφωσης της εικόνας και ο 

αριθμός των εικόνων που εναλλάσσονται σε ένα δευτερόλεπτο. 
 Title Safe Area: αναφέρεται στην περιοχή την οποία έχουμε οριοθετήσει η 

να βάλλουμε τους τίτλους. 
 Action Safe Area: αναφέρεται στην ενεργή περιοχή που επιτρέπεται να 

εμφανιστούν οι τίτλοι. 
 Sample Rate: αναφέρεται στο ήχο και δηλώνει τον αριθμό των 

δειγμάτων. 
 Display Format: αναφέρεται στον τρόπο διαμόρφωσης του ήχου. 

 Capture: 



19 

 

 Capture Format: αναφέρεται στον τρόπο μετεγγραφής της ταινίας. Η 
επιλογή αυτή γίνεται στην κατηγορία General, οπότε σε αυτή την 
περίπτωση είναι περιττή. 

 Video Rendering: Αναφέρεται στην απόδοση ενός βίντεο και δεν υπάρχει 
επιλογή προεπισκόπησης αν επιλεγεί η κατηγορία DV ή HDV. Οι επιλογές 
αυτές εμφανίζονται μόνο αν επιλεγεί η κατάσταση επεξεργασίας Desktop. 
 File Format: 
 Compressor: 
 Color Depth: 

 Default Sequence: Η κατηγορία αυτή προεπιλεγεί την αλληλουχία των πλάνων 
τόσο του ήχου όσο και της εικόνας. 
 Video: Αναφέρεται στις τηλεοπτικές διαδρομές (video trucks) των 

πλάνων. 
 Audio: Αναφέρεται στην μορφή την οποία έχει ο ήχος ο οποίος 

αποθηκεύεται (π.χ. master, mono, mono submix, stereo, stereo submix, 
5.1, 5.1 submix) 

 
Το πάνελ Custom Settings 
Στο πάνελ αυτό οι ρυθμίσεις προϋπάρχουν (προκαθορισμένες ρυθμίσεις) ανάλογα 
με το σύστημα που θα χρησιμοποιηθεί. Τα συστήματα είναι: 
 DV-24P : Έχει τη δυνατότητα να χρησιμοποιηθεί με κάμερες οι ειδικευμένης 

χρήσης (24p DV) με καθώς και για ταινίες που έχουν τραβηχτεί με σταθερή 
ταχύτητα 24 καρέ το δευτερόλεπτο και έχουν μεταφερθεί σε μορφή DV. Τα 
χαρακτηριστικά της φαίνονται στον πίνακα 1 που ακολουθεί. 
 

ΠΙΝΑΚΑΣ 1 

 Standard   
32 KHz 

Standard   
48 KHz 

Widescreen  
32 KHz 

Widescreen  
48 KHz 

Editing Mode DV 24P 

Timebase 23,976 fps 

Frame Size 720h 480v 4:3 720h 480v 16:9 

Frame Rate 23,976 fps 

Pixel Aspect Ratio D1/DV NTSC D1/DV NTSC widescreen 16:9 

Fields No fields (Progressive Scan) 

Display Format 2:3:3:2 pull-up for playback to a DV device 

Sample Rate:  32000 Hz 
(12 bit) audio 

48000 Hz 
(16 bit) audio 

32000 Hz 
(12 bit) audio 

48000 Hz 
(16 bit) audio 

Display Format:  Audio Samples 

 
 DV-NTSC: Είναι το πρότυπο προβολής τηλεοπτικής εικόνας που 

χρησιμοποιείται στην Αμερικανική ήπειρο και την Ιαπωνία. Τα χαρακτηριστικά 
της φαίνονται στον πίνακα 2. 

ΠΙΝΑΚΑΣ 2 

 Standard   
32 KHz 

Standard   
48 KHz 

Widescreen  
32 KHz 

Widescreen  
48 KHz 
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Editing Mode DV NTSC 

Timebase 23,976 fps 

Frame Size 720h 480v 4:3 720h 480v 16:9 

Frame Rate 23,976 fps 

Pixel Aspect Ratio D1/DV NTSC D1/DV NTSC widescreen 16:9 

Fields Lower field first    

Display Format Drop-Frame Timecode numbering 

Sample Rate:  32000 Hz 
(12 bit) audio 

48000 Hz 
(16 bit) audio 

32000 Hz 
(12 bit) audio 

48000 Hz 
(16 bit) audio 

Display Format:  Audio Samples 

 
 DV-PAL: Είναι το πρότυπο προβολής τηλεοπτικής εικόνας που χρησιμοποιείται 

στο μεγαλύτερο μέρος της ∆υτικής Ευρώπης και της Αυστραλίας. 
Τα χαρακτηριστικά αυτού του προτύπου φαίνονται στην εικόνα 5, όπου 
φαίνονται όταν η εικόνα η έχει την αναλογία 4:3 και ο ήχος είναι 12bit, 
δηλαδή 32 KHz. Αναλυτικότερα μπορείτε να δείτε τα χαρακτηριστικά αυτά 
στον πίνακα 3. 

 

 
ΕΙΚΟΝΑ 5 

 

ΠΙΝΑΚΑΣ 3 

 Standard   
32 KHz 

Standard   
48 KHz 

Widescreen  
32 KHz 

Widescreen  
32 KHz 

Editing Mode DV PAL 

Timebase 25,00 fps 
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Frame Size 720h 576v 4:3 720h 576v 16:9 

Frame Rate 25,00 fps 

Pixel Aspect Ratio D1/DV PAL D1/DV PAL Widescreen 16:9 

Fields Lower field first 

Sample Rate:  32000 Hz 
(12 bit) audio 

48000 Hz 
(16 bit) audio 

32000 Hz 
(12 bit) audio 

48000 Hz 
(16 bit) audio 

Display Format:  Audio Samples 

 
 HDV: Η φόρμα αυτή χρησιμοποιείται για την εγγραφή συμπιεσμένου βίντεο 

πολύ μεγάλης ευκρίνειας (HD : High Definition), σε στάνταρ DV. Τα 
χαρακτηριστικά του φαίνονται στον πίνακα 4. 

 
 
 
 
 
 
 

ΠΙΝΑΚΑΣ 4 

 HDV 
1080i25 

(50i) 

HDV 
1080i30 

(60i) 

HDV 
1080p25 

(50p) 

HDV 
1080p30 

(60p) 

HDV 
720p25 

HDV 
720p30 

Editing Mode HDV 1080i HDV 1080p HDV 720p 

Timebase 25,00 fps 29,97 fps 25,00 fps 29,97 fps 25,00 fps 29,97 fps 

Frame Size 1440h 1080v  16:9 1280h 720v   16:9 

Frame Rate 25,00 fps 29,97 fps 25,00 fps 29,97 fps 25,00 fps 29,97 fps 

Pixel Aspect 
Ratio 

HD Anamorphic 1080 Square Pixels 

Fields Upper field first No fields (Progressive 
Scan) 

Display Format  Drop 
Frame 

Time-code 
numbering 

 Drop 
Frame 

Time-code 
numbering 

 Drop 
Frame 

Time-code 
numbering 

Sample Rate:  48000 Hz audio 

Display 
Format:  

Audio Samples 

 
 Mobile & Devices: Χρησιμοποιείται για ειδικά βίντεο που προέρχονται από 

φορητές συσκευές (π.χ. Κινητά τηλέφωνα) και άλλα μέσα χαμηλού εύρους 
ζώνης. Τα χαρακτηριστικά του, ανάλογα με την κατηγορία, φαίνονται στον 
πίνακα 5. 

ΠΙΝΑΚΑΣ 5 

 CIF, QCIF, QQCIF iPOD, QVGA, Sub-QCIF 



22 

 

Editing Mode Desktop 

Timebase 15,00 fps 

Frame Size 352h 288v 11:9 640h 480v 4:3 

Frame Rate 15,00 fps 

Pixel Aspect Ratio Square Pixels 

Fields No fields (Progressive Scan) 

 
Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο:  Οι επιμορφούμενοι ανοίγουν μπαίνουν στο διαδίκτυο και συλλέγουν 
πληροφορίες για το πρόγραμμα. 
Βήμα 2ο:  Συγκεντρώνουν τις πληροφορίες και συζητούν για αυτές με τον 
επιμορφωτή. 
Βήμα 3ο: ∆ημιουργούν έναν πίνακα με τις δυνατότητες που έχει το λογισμικό.  
Που Βήμα 4ο: Βρίσκουν άλλα λογισμικά τα οποία κάνουν την ίδια δουλειά με το 
συγκεκριμένο λογισμικό. 
Βήμα 5ο: Συλλέγουν πληροφορίες για τις δυνατότητες του καθενός από τα 
λογισμικά αυτά. 
Βήμα 6ο: Συγκρίνουν τα χαρακτηριστικά των προκαθορισμένων ρυθμίσεων. 
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∆ραστηριότητα 2η:  
Ξενάγηση στο περιβάλλον του Adobe Premier Pro CS3 – η φιλοσοφία του 

 
α. Γενικά 
 
Η δραστηριότητα αφορά στην παρουσίαση του λογισμικού Adobe Premier Pro CS3 
και στη χρήση των βασικών εντολών ηλεκτρονικής συνάρμοσης και επεξεργασίας  
εικόνας 
 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ενότητες: Περιήγηση στο Adobe Premier Pro CS3 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να γνωρίζει τις λειτουργίες και τις δυνατότητες του λογισμικού Adobe Premier 

Pro CS3 
 Να εξοικειωθεί με το περιβάλλον του Adobe Premier Pro CS3. 
 Να γνωρίσει τα πλαίσια διαλόγου, την οθόνη εργασίας και τις γραμμές 
εργαλείων. 

 Να αλλάζει τη μορφή της γραμμής εργαλείων. 
 Να γνωρίσει την περιοχή εντολών. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 

 
Ρόλος ομάδας επιμορφούμενων 
Στην εισαγωγική αυτή δραστηριότητα γίνεται η γνωριμία των μελών των ομάδων 
μεταξύ τους. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
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Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
 
Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
O επιμορφωτής παρουσιάζει στους επιμορφούμενους βασικές αρχές λειτουργίας 
του Adobe Premier Pro CS3, σχετικά με την εκτέλεση του προγράμματος. Η οθόνη 
εργασίας του Adobe Premier Pro CS3 απεικονίζεται στην εικόνα 6. 
 

 
EΙΚΟΝΑ 6 
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Στην οθόνη εμφανίζεται η διάταξη του χώρου εργασίας όπου το κάθε συστατικό 
του χώρου εμφανίζεται σε δικό του πάνελ. Τα περισσότερα πάνελ μπορούν να 
σταθεροποιηθούν σε ένα μόνο παράθυρο, ενώ ορισμένα από αυτά, τα βασικά 
συστατικά του προγράμματος, έχουν το δικό τους παράθυρο. Αυτά είναι: 
 Το πάνελ Timeline 
 Το πάνελ Project 
 
Το πάνελ Timeline 
Το πάνελ Timeline (διάγραμμα ροής χρόνου) είναι ο χώρος όπου γίνεται το 
μεγαλύτερο μέρος της επεξεργασίας. Με την βοήθεια του δημιουργούνται 
αλληλουχίες πλάνων, ή τοποθετούνται ένθετα πλάνα μέσα σε αυτό (εικόνα 7). 
 

 
EΙΚΟΝΑ 7 

Το πάνελ Project 
Το πάνελ Project (πρόγραμμα) είναι αυτό μέσα στο οποίο εισαγάγουμε όλα τα 
αρχεία που θα μας βοηθήσουν στη διαμόρφωση της ταινίας. Τα αρχεία αυτά μπορεί 
να είναι οι εικόνες, βίντεο, ήχος και οτιδήποτε άλλο θα χρειαστεί να 
χρησιμοποιηθεί για τη δημιουργία της τελικής ταινίας (εικόνα 7). 
Το πάνελ του προγράμματος αποτελείται από δύο μέρη: 
 Στο πάνω μέρος απεικονίζεται ένα μικρό τετράγωνο μέσα στο οποίο 

εμφανίζεται η εικόνα του αρχείου που βρίσκεται στο κάτω μέρος. Επίσης, αν 
το αρχείο είναι βίντεο τότε απεικονίζεται το πρώτο καρέ του βίντεο. Όταν 
πρόκειται για ήχο, εμφανίζεται το φάσμα ενός ήχου. 

 Στο κάτω μέρος απεικονίζονται όλα τα αρχεία που έχουμε εισαγάγει. Στο 
σημείο αυτό μπορούμε να δημιουργήσουμε φακέλους και υποφακέλους, μέσα 
στους οποίους θα τοποθετηθούν όλα τα αρχεία ή ορισμένα από αυτά ανάλογα 
με τις κατηγορίες που θέλουμε να τα χωρίσουμε. 

 
Το πάνελ Tools 
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Το πάνελ Tools (εργαλεία) (εικόνα 9) περιέχει χρήσιμα εργαλεία που 
χρησιμοποιούνται για την τελική διαμόρφωση της ταινίας. Τα εργαλεία αυτά, όπως 
απεικονίζονται στην εικόνα 8, από αριστερά προς τα δεξιά, είναι: 

 
EΙΚΟΝΑ 8 

 
 Selection (επιλογή): Οι χρήσεις του είναι πάρα πολλές, με τα εργαλεία αυτό 

μπορεί να γίνει επιλογή και κοπή, μεταφορά και απόθεση και άλλες. 
 Track Select (επιλογή καναλιού): Η λειτουργία του είναι λίγο πιο σύνθετη από 

τη λειτουργία του εργαλείου επιλογής, για το λόγο αυτό δεν πρέπει να τα 
μπερδεύεται μεταξύ τους. Μπορεί να επιλέξει περισσότερα από ένα κανάλια, με 
τη βοήθεια του shift και να κάνετε διάφορες εργασίες σε αυτά, όπως αποκοπή 
και επικόλληση, αντιγραφή και επικόλληση, ολίσθηση ή διαγραφή. 

 Ripple Edit (επεξεργασία / μοντάζ με μεταφορά): Χρησιμοποιείται για να 
ενώσουμε δύο διαφορετικά βίντεο κλιπ χωρίς να υπάρχει διάφορα ανάμεσα σε 
αυτά, πράγμα το οποίο φαίνεται και στην προεπισκόπηση. 

 Rolling Edit (επεξεργασία / μοντάζ με αντικατάσταση): Χρησιμοποιείται για να 
ενωθούν δύο γειτονικά κλιπ, κόβοντας τον ίδιο αριθμό καρέ από το καθένα. 

 Rate Stretch (αυξομείωση ταχύτητας): Μεγαλώνει ή μικραίνει το χρόνο ενός 
βίντεο κλιπ, αυξομειώνοντας την ταχύτητα του (αργή κίνηση ή επιτάχυνση). 

 Razor (ξυράφι): Είναι ορολογία που έχει μείνει από τον κινηματογράφο. Κόβει 
ένα βίντεο κλιπ στα δύο για να επεξεργαστούμε το κάθε κομμάτι χωριστά, 
βγάζοντας διαφορετικά εφέ ή ήχο στο κάθε κομμάτι. 

 Slip (ολίσθηση): Το εργαλείο αυτό χρησιμοποιείται για την αλλαγή του 
αρχικού ή του τελικού καρέ, χωρίς να επηρεάσει τα γειτονικά βίντεο κλιπ ή να 
αλλάξει την διάρκειά του. 

 Slide (μετατόπιση): Χρησιμοποιείται για να μετατοπίσουμε ένα βίντεο κλιπ, 
τόσο δεξιά όσο και αριστερά, χωρίς να αλλάξει το μήκος της ταινίας, γιατί 
μετακινούμενο κόβει καρέ από την αρχή το επόμενου ή το τέλος του 
προηγούμενου. 

 Pen το (πένα): Χρησιμοποιείται για να προσθέτει, να μετακινεί, να διαγραφεί 
καρέ-κλειδιά. Επίσης δημιουργεί ή προσαρμόζει καμπύλες στο παράθυρο 
Titler, στο πάνελ Effect Controls και στο μόνιτορProgram 

 Hand (χέρι): Χρησιμοποιείται για τη μετακίνηση μιας ολόκληρης σεκάνς, 
πιάνοντας μόνο ένα κλιπ αυτής και σέρνοντας αυτό. 

 Zoo (ζουμ): Χρησιμοποιείται για μεγέθυνση ή σμίκρυνση, η προεπιλογή του 
είναι στη μεγέθυνση. 
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EΙΚΟΝΑ 9 

 
Το πάνελ Effects 
Το πάνελ Effects (εικόνα 9) περιέχει τρεις καρτέλες. Οι καρτέλες αυτές είναι η Info 
(περιέχει διάφορες πληροφορίες για το περιεχόμενο των αρχείων), η History 
(περιέχει πληροφορίες για το ιστορικό της δημιουργίας του βίντεο) και η Effects 
(περιέχει διάφορα εφέ). 
Τα εφέ του πάνελ Effects είναι ομαδοποιημένα σε πέντε κατηγορίες. Σκοπός τους 
είναι η δημιουργία έφερε τόσο για τον ήχο όσο και για την εικόνα. Οι κατηγορίες 
του πάνελ Effects είναι: 
 Presets ( προκαθορισμένα εφέ ) 
 Audio Effect ( ηχητικά εφέ) 
 Audio Transitions ( ηχητικά εφέ αλλαγής πλάνου ) 
 Video Effect ( οπτικά εφέ ) 
 Video Transitions (εφέ αλλαγής πλάνου βίντεο ) 
 
Το πάνελ Audio Mixer (μίκτης ήχου) 
Το πάνελ του μίκτη ήχου (εικόνα 9) περιέχει μόνο το γενικό (master) ρυθμιστή 
του ήχου. Περισσότερα αναφέρονται στο πάνελ πηγαίου βίντεο . 
 
Το πάνελ πηγαίου βίντεο 
Το πάνελ πηγαίου βίντεο (εικόνα 11) περιέχει τρεις καρτέλες, οι οποίες είναι: 
Source  (πηγή): Απεικονίζει την εικόνα ή οποιοδήποτε άλλο αρχείο επιλέγεται στο 
sequence του πάνελ Project. 
Effect Controls (έλεγχοι των εφέ): Είναι το ίδιο με την καρτέλα του πάνελ Effects. 
Audio Mixer (μίκτης ήχου): Προβάλλοντας την καρτέλα του Audio Mixer, 
εμφανίζεται μια μικρή κονσόλα ήχου τριών καναλιών. Επίσης διαθέτει και την 
ρύθμιση master, για την οποία αναφερθήκαμε προηγουμένως. Το κάθε κανάλι 
περιέχει έναν ρυθμιστή της έντασης του ήχου και έναν ρυθμιστή για το balance 
(εικόνα 10). 
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EΙΚΟΝΑ 10 

Το πάνελ Program sequence 
Στο πάνελ Program sequence (Ακολουθία προγράμματος ή διαμορφωθέν 
πρόγραμμα) εμφανίζεται η τελική μορφή του βίντεο την οποία θα έχει. Εκεί μπορεί 
να γίνει και αναπαραγωγή του βίντεο κάνοντας κλικ στο εικονίδιο αναπαραγωγής. 
Αν δεν γίνεται αναπαραγωγή, η εικόνα που θα εμφανίζεται εξαρτάται από το 
σημείο που είναι η ρίγα στο πάνελ TimeLine. Το κάναμε αυτό εμφανίζεται στην 
εικόνα 11. 
 

 
EΙΚΟΝΑ 11 
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Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο:  Οι επιμορφούμενοι ανοίγουν ένα από τα δείγματα που συνοδεύουν το 
λογισμικό και βρίσκεται στο φάκελο samples. 
Βήμα 2ο: Επιλέγουν απλά εργαλεία ή εφέ και προσπαθούν να τα χρησιμοποιήσουν 
για να δουν τη λειτουργία τους και να εξοικειωθούν περισσότερο με αυτές. 
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∆ραστηριότητα 3η:   
∆ημιουργία νέας ταινίας - Εισαγωγή δεδομένων 

 
α. Γενικά 
 
Η δραστηριότητα αφορά το χειρισμό βασικών εντολών για την είσοδο εικόνων και 
ήχου και την επεξεργασία αυτών για τη δημιουργία μιας ταινίας που θα προβάλει 
εικόνες . 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ενότητες: ∆ημιουργία νέας ταινίας - Εισαγωγή δεδομένων 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να γνωρίζει το περιβάλλον εργασίας του λογισμικού Adobe Premier Pro CS3 
 Να εξοικειωθεί με το περιβάλλον του Adobe Premier Pro CS3. 
 Να γνωρίσει πως γίνεται η ένωση των εικόνων για τη δημιουργία μιας ταινίας. 
 Να μπορεί να προσθέτει ήχο και εφέ στην ταινία. 
 Να γνωρίσει την περιοχή εντολών. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 

 
Ρόλος ομάδας επιμορφούμενων 
Στην εισαγωγική αυτή δραστηριότητα γίνεται η γνωριμία των μελών των ομάδων 
μεταξύ τους. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
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Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
 
Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων 
 Ηλεκτρονικό βοηθητικό υλικό. 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
O επιμορφωτής παρουσιάζει στους επιμορφούμενους τον τρόπο με τον οποίο 
μπορούν να εισαχθούν αρχεία στο λογισμικό μέσω του πάνελ Project. Στο πάνελ 
Project  του Adobe Premier Pro CS3 κάνετε διπλό αριστερό κλικ στο κενό κάτω 
από το sequence. Παρουσιάζεται ένα παράθυρο, όπως βλέπετε στην εικόνα 12. 
 

 
EΙΚΟΝΑ 12 

Επιλογή αρχείων 
Ψάχνετε να βρείτε τα αρχεία που θα σας χρησιμεύσουν για την δημιουργία της 
ταινίας. Με τη βοήθεια το πλήκτρο Ctrl επιλέγεται τα συγκεκριμένα αρχεία που 
θέλετε. Επιλέγοντας την επιλογή άνοιγμα, τα αρχεία που έχετε επιλέξει εισάγονται 
στο πρόγραμμα και συγκεκριμένα κάτω από το sequence. 
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Εάν όλα τα αρχεία που θέλετε, δεν είναι στον ίδιο φάκελο τότε επαναλαμβάνετε 
την παραπάνω διαδικασία μέχρις ότου εισάγεται στη συγκεκριμένη θέση όλα τα 
αρχεία που θέλετε (εικόνα 13). 
 

 
EΙΚΟΝΑ 13 

 
Όπως βλέπετε στην εικόνα, στο πάνω αριστερό μέρος εμφανίζεται η εικόνα, εκείνη 
του αρχείου που είναι επιλεγμένο, στη συγκεκριμένη περίπτωση έχει ανοιχθεί το 
αρχείο «eikona008.jpg». Αν το αρχείο ήταν μουσικής τότε δεν θα εμφανιζόταν να 
εικόνα, αλλά κάποιο μεγάφωνο ή η κυματομορφή ενός ακουστικού σήματος. 

 
EΙΚΟΝΑ 14 

 

Μπορείτε να σβήσετε ένα αρχείο το οποίο δεν το θέλετε να κάνοντας δεξί κλικ 
πάνω σ' αυτό και επιλέγοντας την εντολή clear,  όπως φαίνεται στην εικόνα 14. 
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Επίσης μπορείτε να δείτε περισσότερες πληροφορίες για τα αρχεία πηγαίνοντας τον 
κέρσορα στην άκρη του πάνελ και κρατώντας πατημένο το αριστερό κλικ το 
σύρεται προς τα δεξιά μέχρι το σημείο που θέλετε (εικόνα 15). 
 

 
EΙΚΟΝΑ 15 

 
Εισαγωγή εικόνων 
Στη συνέχεια σύρεται τις εικόνες στο πάνελ του TimeLine και στη γραμμή Video 1, 
με τη σειρά που εσείς θέλετε. Οι εικόνες θα εμφανιστούν συρρικνωμένες στο 
αριστερό άκρο της γραμμής (εικόνα 16).  

 
EΙΚΟΝΑ 16 
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Όπως βλέπετε, στο πάνελ του πηγαίου βίντεο θα εμφανιστεί η εικόνα εκείνη πάνω 
στην οποία έχουμε κάνει διπλό κλικ. 
Πηγαίνοντας τον κέρσορα στο δεξιό άκρο της δεξιάς εικόνας και κρατώντας 
πατημένο το δεξί κλικ του ποντικιού, επεκτείνετε τον χρόνο της εικόνας μέχρι το 
σημείο που θέλατε. Το ίδιο θα κάνατε και με το αριστερό άκρο της εικόνας. 
Επαναλαμβάνετε το ίδιο για όλες τις εικόνες μέχρις ότου δώσετε τη διάρκεια που 
θέλετε σε κάθε εικόνα. Τελικά, η οθόνη σας θα έχει τη μορφή που απεικονίζεται 
στην εικόνα 17. 

 
EΙΚΟΝΑ 17 

Στο πάνελ του Program Sequence εμφανίζεται η εικόνα πάνω στην οποία βρίσκεται 
η γραμμή του χρόνου εκτέλεσης, στο πάνελ TimeLine. Προχωρώντας η γραμμή και 
αλλάζοντας εικόνα, θα αλλάζει και η εικόνα που εμφανίζεται στο παραπάνω πάνελ. 
Όταν η εικόνα είναι πολύ μικρή (μικρή ανάλυση), τότε δεν θα καταλαμβάνει 
ολόκληρο το χώρο του Program Sequence, αλλά θα αφήνει μαύρο κενό γύρω της. 
Όταν η εικόνα είναι πολύ μεγάλη (μεγάλη ανάλυση), τότε δεν θα εμφανίζεται όλη 
εικόνα αλλά μέρος αυτής. Για την διόρθωση αυτών των δύο σφαλμάτων, 
ακολουθούμε την παρακάτω διαδικασία. 

 
EΙΚΟΝΑ 18 
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Κάνετε δεξί κλικ πάνω στην εικόνα και επιλέγεται την εντολή «scale to frame size» 
(εικόνα 18). Μετά απ' αυτή τη διαδικασία η εικόνα θα εμφανισθεί να καταλαμβάνει 
ολόκληρο τον χώρο, όπως απεικονίζεται στην εικόνα 19. 

 
EΙΚΟΝΑ 19 

 
Εάν δεν θέλετε να καταλαμβάνει η εικόνα ολόκληρο το χώρο τότε, με την ίδια 
διαδικασία αποχαρακτηρίζετε (απενεργοποιείτε) την εντολή «scale to frame size». 

 
EΙΚΟΝΑ 20 

 
Στο πάνελ του Project μπορείτε να επιλέξετε την εμφάνιση των αρχείων. Εάν 
θέλετε να μην εμφανίζονται η πρώτη μορφή ονόματος αλλά σαν εικονίδια, τότε 
στο κάτω αριστερό του σημείο επιλέγεται το εικονίδιο, όπως φαίνεται και στην 
εικόνα 20. 
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Εισαγωγή ήχου 
Τα αρχεία ήχου τα εισάγουμε με τον ίδιο τρόπο που εισάγουμε και τις εικόνες. 
Παίρνουμε το αρχείο ήχου που θέλουμε και το σύρουμε στο πάνελ του TimeLine 
και στη γραμμή Audio 1. Με τον ίδιο τρόπο που γίνεται και με τις εικόνες, 
ρυθμίζετε και τη διάρκεια του ήχου. Μπορείτε να προσθέσετε διαφορετικά αρχεία 
ήχου, όπως φαίνεται στην εικόνα 21. 

 
EΙΚΟΝΑ 21 

 
 3ο:  Εφαρμογή  
Βήμα 1ο:  Από το αρχείο εικόνων που σας δίνετε επιλέξτε 6 εικόνες. Προσπαθήστε 
να έχουν κάποια σχέση μεταξύ τους ούτως ώστε να μπορέσετε να την συνδυάσετε 
και να τις τοποθετήσετε στη σειρά. 
Βήμα 2ο: Ρυθμίστε τις εικόνες ούτως ώστε να έχουν διάρκεια ενάμισι λεπτό η 
καθεμία και να καταλαμβάνουν όλο το χώρο χωρίς να αφήνουν κενά γύρω τους. 
Αν η εικόνα είναι μεγάλης ανάλυσης, φροντίστε ώστε να εμφανίζεται ολόκληρη και 
όχι μέρος αυτής. 
Βήμα 3ο:  Προσθέστε τρία αρχεία ήχου τα οποία θα τοποθετηθούν στη γραμμή 
Audio 1. Η διάρκεια το κάθε αρχείου ήχου θα πρέπει να είναι ίση με τη διάρκεια 
της κάθε εικόνας. Τα αρχεία ήχου θα τοποθετηθούν από δύο φορές το καθένα και 
όχι συνεχόμενα τα ίδια αρχεία. 
Βήμα 4ο: ∆ημιουργήστε έναν φάκελο και δύο υποφακέλους στο πάνελ του project 
και βάλτε μεσαία τα αρχεία ήχου στον έναν υποφάκελο και τα αρχεία εικόνων στον 
άλλον. 
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∆ραστηριότητα 4η:   
Προσθήκη εφέ στην εναλλαγή των πλάνων 

 
α. Γενικά 
 
Η δραστηριότητα αφορά το χειρισμό βασικών εντολών για την δημιουργία εφέ 
στην εναλλαγή των πλάνων και στις εικόνες που αποτελούν μια ταινία. 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

 Της νόμου Προσθήκη εφέ στην εναλλαγή των πλάνων. 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να μπορεί μια ένωση μεταξύ τους δύο πλάνα με τη βοήθεια του λογισμικού 

Adobe Premier Pro CS3 
 Να μπορεί να προσθέτει εφέ όταν στην ταινία μεταβαίνει από το ένα πλάνο στο 
άλλο. 

 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 

 
Ρόλος ομάδας επιμορφούμενων 
Στην εισαγωγική αυτή δραστηριότητα γίνεται η γνωριμία των μελών των ομάδων 
μεταξύ τους. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
 
Επιμορφούμενος Γ: 3ος Μελετητής 
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∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
 Ηλεκτρονικό βοηθητικό υλικό 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
O επιμορφωτής παρουσιάζει στους επιμορφούμενους τον τρόπο με τον οποίο 
μπορούν να πρόσθετων κάποια εφέ κατά την εναλλαγή των εικόνων. Τα εφέ αυτά 
είναι διαφόρων ειδών και μπορείτε να τα συνδυάσετε με τις εικόνες ή να είναι 
κάποια φαντασμαγορικά εφέ. 
Η εντολή που ενεργοποιεί τα εφέ, είναι: 

Window > Workspace > Effects 

 
ΕΙΚΟΝΑ 22 
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Μετά την ενεργοποίηση αυτής της εντολής, βλέπετε ότι αλλάζει ο χώρος εργασίας 
του προγράμματος. Το πάνελ των Effects καταλαμβάνει ολόκληρη την αριστερή 
πλευρά της οθόνης. Εκεί πέρα παρουσιάζονται τα διάφορα εφέ ανά κατηγορία. Ο 
κάθε φάκελος αποτελεί και μια κατηγορία των εφέ, όπως βλέπετε και στην εικόνα 
22. 
Για να μπορέσετε να δημιουργήσετε μια ταινία με εφέ, αρκεί να σύρεται τα αρχεία 
το βιντεοκλίπ ή των εικόνων, από το πάνελ Project στο κανάλι Video 1 του πάνελ 
TimeLine. 
 
Προετοιμασία για τη δημιουργία εφέ 
Όταν κάνετε αυτές τις ενέργειες θα παρατηρήσατε ότι στην αρχή το κάθε 
βιντεοκλίπ εμφανίζεται ένα κίτρινο σήμα. Αυτό σημαίνει ο και το βιντεοκλίπ είναι 
σε πλήρη ανάπτυξη. Θα πρέπει να δημιουργήσετε κάποιες προϋποθέσεις, ώστε να 
μπορείτε να προσθέσετε τα εφέ ανάμεσά τους. 
Αυτό γίνεται με τη βοήθεια το εργαλείου Ripple Edit από τη γραμμή εργαλείων. 
Πριν όμως ξεκινήσετε την προετοιμασία, θα πρέπει να αναπτύξετε τον χώρο που 
καταλαμβάνουν τα βιντεοκλίπ σε όλο το μήκος της οθόνης. Αυτό γίνεται αν 
πατήσετε το πλήκτρο της ανάστροφης καθέτου (\). 
Με το εργαλείο Ripple Edit δουλεύετε ως εξής: 
 Ενεργοποιείτε το εργαλείο. Όταν πλησιάζετε τον κέρσορα ανάμεσα σε δύο 

βιντεοκλίπ, θα παρατηρήσετε ότι αυτός παίρνει τη μορφή το εργαλείου. 
 Πηγαίνετε τον κέρσορα ανάμεσα στο πρώτο και δεύτερο βιντεοκλίπ και 

κρατώντας πατημένο το αριστερό κλικ, μετακινείται το τέλος το βιντεοκλίπ 
προς τα αριστερά για δύο ή τρία δευτερόλεπτα. 

 Επαναλαμβάνεται το ίδιο και στην αρχή του επόμενου βιντεοκλίπ, το οποίο 
μετακινείται προς τα δεξιά, για το ίδιο χρονικό διάστημα. 

Με αυτό τον τρόπο προετοιμάζεται τα βιντεοκλίπ ούτως ώστε να μπορούν να 
δεχθούν τα εφέ αλλαγής πλάνου. 
 
∆ημιουργία εφέ 
Στο παρόν κεφάλαιο θα παρουσιαστούν μόνο ορισμένα από την πληθώρα των εφέ, 
τα  οποία έχει τη δυνατότητα να δημιουργήσει το λογισμικό αυτό. Το μεγαλύτερο 
αριθμό από τα εφέ, θα έχετε τη δυνατότητα να ανακαλύψετε κατά το στάδιο της 
εφαρμογής. 
Μέσα στο πάνελ Effects υπάρχουν πέντε φάκελοι. Ο φάκελος τον οποίο θα 
χρησιμοποιήσετε είναι ο Video Transition. Εκεί μέσα υπάρχουν αρκετοί 
υποφάκελοι, ο καθένας από τους οποίους περιέχει έναν αριθμό αρχείων. Τα αρχεία 
αυτά είναι τα αρχεία των εφέ 
Η διαδικασία που ακολουθείται για την πρόσθεση των εφέ αλλαγής πλάνου, είναι 
αρκετά εύκολη. Πηγαίνετε στο πάνελ των Effects και ανοίγεται τον φάκελο μέσα 
στον οποίο είναι το εφέ που θέλετε να χρησιμοποιήσετε. Επιλέγεται το εφέ το 
οποίο θέλετε να χρησιμοποιήσετε και όπως παρατηρείται το τετραγωνίδιο αυτού 
του εφέ, γίνεται κόκκινο (εικόνα 23). Κάνετε δεξί κλικ πάνω στο τετράγωνο του 
εφέ που θέλετε να χρησιμοποιήσετε και το σύρετε ανάμεσα στα δύο βιντεοκλίπ. 
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ΕΙΚΟΝΑ 23 

 
Για να δείτε πως λειτουργεί το εφέ, πατάτε το Spacebar και βλέπετε ότι το 
βιντεοκλίπ αρχίζει να προβάλλεται, καθώς κινείται το CIT (είναι κάθετη γραμμή 
που μας δείχνει ποιο σημείο της εικόνας η του βιντεοκλίπ αναπαράγεται στην 
τρέχουσα χρονική στιγμή). Με τον ίδιο τρόπο μπορείτε να σταματήσετε την 
αναπαραγωγή το βιντεοκλίπ. 
 
Παρουσίαση ορισμένων εφέ 
Στη συνέχεια θα παρουσιαστούν ορισμένα από τα εφέ και θα εξηγηθεί το 
αποτέλεσμα που θα έχετε αν τα χρησιμοποιήσετε. Αυτά φαίνονται στον πίνακα 6 
που ακολουθεί.  

ΠΙΝΑΚΑΣ 6 

 Φάκελος Video Transition 

ΟΝΟΜΑ 
ΥΠΟΦΑΚΕΛΟΥ 

ΟΝΟΜΑ 
ΑΡΧΕΙΟΥ 

ΕΜΦΑΝΙΣΗ 

Dissolve Cross Dissolve Μειώνει σιγά-σιγά τη φωτεινότητα του 
πρώτου πλάνου μέχρις ότου εμφανιστεί το 
επόμενο 

3D Motion Flip Over Είναι σαν ένας πίνακας που στηρίζεται στο 
πάνω και κάτω μέσω του και περιστρέφεται, 
όποτε εμφανίζεται πίσω του πλευρά. Στην 
μπροστινή πλευρά είναι η εικόνα του 
πρώτου βιντεοκλίπ και στην πίσω πλευρά η 
εικόνα του δεύτερο βίντεο περίπου, η οποία 
εμφανίζεται μετά την περιστροφή. 
Αν από την καρτέλα Effects Control επιλέγει 
η εντολή για Reverse, η εικόνα στρέφεται 
προς την αντίθετη πλευρά. 



41 

 

Page Peel Cross Dissolve  Είναι σαν να παίρνετε το πάνω αριστερό 
άκρο της εικόνας και σαν να είναι ένα 
φύλλο χαρτί τότε τραβάτε και καθώς 
διπλώνεται, εμφανίζεται η επόμενη εικόνα 
από πίσω. 

 
∆ημιουργία φακέλου αρχείων 
Για να μην ψάχνετε ανάμεσα στο αυτόν τον δαίδαλο των φακέλων και των 
αρχείων, μπορείτε να δημιουργήσετε έναν δικό σας φάκελο μέσα στον οποίο θα 
τοποθετήσετε όλα τα αρχεία με τα οποία φαίνεται να εργαστείτε. 
Στο φάκελο δίνεται το όνομα που εσείς θέλετε. Μπορείτε να τοποθετήσετε τα 
αρχεία μέσα σ' αυτό το φάκελο σύροντάς τα με το ποντίκι. Τα αρχεία που 
τοποθετήσατε μέσα στο φάκελο που δημιουργήσατε, εξακολουθούν να υπάρχουν 
και στο φάκελο που ήταν πριν. Σκοπός της δημιουργίας αυτού του φακέλου είναι 
να μας βοηθήσει, να δουλέψουμε ευκολότερα. 
Όταν τελειώσετε την εργασία μπορείτε να ζητήσετε αυτό το φάκελο χωρίς να 
σβηστούν και τα αρχεία, από τους αρχικούς τους φακέλους. 
 
Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο: Τοποθετήστε έξι εικόνες στη γραμμή Video 1. Η διάρκεια προβολής της 
κάθε εικόνας θα είναι 15 δευτερόλεπτα. 
Βήμα 2ο: Ανοίξτε το φάκελο Video Transition της καρτέλας Effects και 
επεξεργαστείτε όλα τα αρχεία που υπάρχουν μέσα σε αυτόν. 
Βήμα 3ο:  Επιλέξτε 6 αρχεία οπτικών εφέ, για να τα τοποθετήσετε στην αρχή της 
πρώτης εικόνας και ανάμεσα από τις υπόλοιπες εικόνες. Τα αρχεία αυτά θα τα 
τοποθετήσετε μέσα σε ένα φάκελο τον οποίο θα έχετε ήδη δημιουργήσει. 
Βήμα 4ο: ∆ημιουργήστε τις δικές σας παρουσίαση των εικόνων μετά ειδικά εφέ που 
θα έχετε τοποθετήσει κατά την εναλλαγή από τη μία εικόνα στην άλλη. 
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∆ραστηριότητα 5η:   
Προσθήκη εφέ σε εικόνες και βίντεο 

 
α. Γενικά 
 
Η δραστηριότητα αφορά το χειρισμό βασικών εντολών για την δημιουργία εφέ στις 
εικόνες που αποτελούν μια ταινία. 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ενότητες: Προσθήκη εφέ σε εικόνες και βίντεο. 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να μπορεί να προσθέτει εφέ στις εικόνες του Adobe Premier Pro CS3. 
 Να γνωρίσει τις δυνατότητες το κάθε εφέ και που χρησιμοποιείται το καθένα 
από αυτά. 

 Να μπορεί να προσθέτει οπτικά εφέ στην ταινία. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 

 
Ρόλος ομάδας επιμορφούμενων 
Στην εισαγωγική αυτή δραστηριότητα γίνεται η γνωριμία των μελών των ομάδων 
μεταξύ τους. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
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Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
 Ηλεκτρονικό βοηθητικό υλικό 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
Στο στάδιο αυτό θα εξηγηθεί ο τρόπος με τον οποίο εισάγονται τα διάφορα εφέ για 
την διαμόρφωση των εικόνων ή των βίντεο. Η διαδικασία που ακολουθείται για την 
εμφάνιση των διαφόρων εφέ, είναι η ακόλουθη. Από τη γραμμή εργαλείων 
επιλέγεται: 

Window > Workspace > Effects 
Όπως βλέπετε, η καρτέλα των Effects εμφανίζεται στη θέση του πλαισίου Project. 
Στο επάνω μέρος της καρτέλας, υπάρχει ο φάκελος Video Effects. Ανοίγοντάς τον 
θα εμφανιστεί μια σειρά από υποφακέλους, ο βλέπετε στην εικόνα 24. 
 

 
ΕΙΚΟΝΑ 24 

 
Επειδή ο κάθε υποφάκελος έχει ένα μεγάλο αριθμό αρχείων, εάν θέλετε να 
χρησιμοποιήσετε ορισμένα μόνο εφέ, δημιουργείται έναν δικό σας υποφάκελο και 
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μέσα σε αυτόν βάζετε τα αρχεία που εσείς θέλετε για να είναι πιο εύκολη η χρήση 
τους. Αυτό γίνεται εάν κάνετε δεξί κλικ κάτω από τους φακέλους και επιλέξετε 
δημιουργία φακέλου. Στη συνέχεια σύρετε το κάθε αρχείο που θέλετε και το 
τοποθετείτε στον φάκελο (εικόνα 25). Τα αρχεία που μεταφέρονται στον φάκελο 
που δημιουργήσατε, παραμένουν και στους αρχικούς τους φακέλους. 
 

 
ΕΙΚΟΝΑ 25 

Για να προσθέσετε ένα εφέ σε κάποια εικόνα ή βίντεο, αρκεί να σύρεται το αρχείο 
του εφέ, στον χώρο που καταλαμβάνει η εικόνα ή το βίντεο στο διάγραμμα ροής 
χρόνο του Video 1 στο πάνελ TimeLine. 
 
Ασπρόμαυρες εικόνες 

 
ΕΙΚΟΝΑ 26 
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Αν θέλετε η εικόνα ή το βίντεο να μην είναι έγχρωμα αλλά να είναι ασπρόμαυρα, 
τότε πηγαίνετε στον πίνακα Effects και ακολουθήστε τη διαδικασία: 

Video Effects > Image Control > Black & White 
όπως φαίνεται και στην εικόνα 26, όπου η φωτογραφία είναι ασπρόμαυρη. 
 
Στο μάθημα αυτό θα αναφερθούν μόνο λίγα από τα εφέ το υπάρχον, γιατί αν 
ανοίξετε το κάθε φάκελο θα διαπιστώσετε ότι υπάρχουν πάρα πολλά εφέ. 
 
Για να σβήσετε τα εφέ που υπάρχουν στο πάνελ Effect Control, αρκεί να κάνετε 
δεξί κλικ στο πάνελ και να επιλέξετε την εντολή «Delete All Effects From Clip». Με 
την εντολή αυτή θα σβηστούν όλα τα εφέ που προστέθηκαν, εκτός από τα 
σταθερά Motion, Opacity και Time Remmaping, τα οποία δεν σβήνουν. 
 
Φλουτάρισμα εικόνας 
Με τον όρο αυτό εννοούμε όταν γίνεται λήψη με χαμηλή ταχύτητα κλείστρου. Η 
διαδικασία εισαγωγής του εφέ αυτού, είναι η ακόλουθη: 

Video Effects > Blur & Sharpen > Directional Blur 
Οπότε εμφανίζεται η εικόνα 27. Κοιτάζοντας το πάνελ Effect Control βλέπετε ότι 
μέσα στο αρχείο εμφανίζονται και ορισμένα άλλα εκτός από το όνομα του αρχείου 
εφέ. Αυτά είναι: 

 
ΕΙΚΟΝΑ 27 

 
 Direction (κατεύθυνση): η οποία δηλώνει την κατεύθυνση που έχει το 

φλουτάρισμα και στη συγκεκριμένη περίπτωση είναι 0,0. 
 Blur Length (μήκος φλουταρίσματος): το οποίο εάν παρατηρήσουμε το 

τρίγωνο με κατεύθυνση προς τα δεξιά, που βρίσκεται αριστερά του τότε θα 
εμφανιστεί μια μπάρα με τιμές από το 0,0 έως 20,0 και ένα βελάκι που 
μετακινώντας στο παρατηρείται ότι αλλάζει η τιμή του Blur Length. 

 Ένα χρονόμετρο το οποίο ενεργοποιεί τη δυνατότητα ορισμό καρέ-κλειδιών. 
 



46 

 

Σφαιρικό τμήμα εικόνας 
Είναι σαν να βάζουμε μια σφαίρα διάφανη σε κάποιο σημείο της εικόνας, στην 
αρχαία δανείζεται στο κέντρο της και μπορούμε να την μετακινήσουμε. Η 
διαδικασία αυτή γίνεται με την επιλογή: 

Video Effects > Distort > Spherize 
Επιλέγοντας τους τριγωνικούς μηχανισμούς, θα εμφανιστούν οι παράμετροι της 
εντολής, όπως φαίνεται στην εικόνα 28. 
 

 
ΕΙΚΟΝΑ 28 

 
Μετακινώντας τον μηχανισμό κύλισης ώστε να πάρει την τιμή 130 θα δείτε ότι 
εμφανίζεται μια σφαιροειδής παραμόρφωση στο κέντρο της εικόνας, όπως φαίνεται 
και στην εικόνα 29. 

 
ΕΙΚΟΝΑ 29 

 
Κάνοντας κλικ στη λέξη Spherize, που βρίσκεται στο πάνελ Effect Controls, 
ενεργοποιείται ο μηχανισμός Transform και εμφανίζεται ένας σταυρός στο κέντρο 
της εικόνας, το οποίο θεωρητικά είναι και το κέντρο της σφαίρας. Κάνοντας δεξί 
κλικ πάνω στο σταυρό και κρατώντας το πατημένο, μπορείτε να μετακινήσετε την 
σφαίρα, σε όποιο σημεία της εικόνας θέλετε, όπως φαίνεται και στην εικόνα 30. 
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ΕΙΚΟΝΑ 30 

 
Η φωτεινότητα της εικόνας 
Μπορείτε να παίξετε με τη φωτεινότητα μιας εικόνας χρησιμοποιώντας την εντολή 
Solarize In. Η εντολή αυτή έχει τη δυνατότητα να αλλάζει τη φωτεινότητα της 
εικόνας. Μπορείτε να το δείτε αν στις εικόνες που ακολουθούν. 

 

 
ΕΙΚΟΝΑ 31 

 

Στην εικόνα 31 είναι η φυσιολογική εικόνα όπου όταν η κλίμακα Threshold τις 
κατηγορίας Solarize  βρίσκεται στο μηδέν τότε έχει τη φωτεινότητα των ηλιακών 
ακτίνων.  
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Αυξάνοντας την κλίμακα εμφανίζεται η εικόνα όπως θα ήταν αν μειονότητα σιγά-
σιγά οι ακτίνες του ήλιου. Έτσι στην εικόνα 32 βλέπετε δύο χαρακτηριστικά 
παραδείγματα οποία οι ακτίνες του ήλιου μειώνονται κατά 50% και 100%. 

 

 
ΕΙΚΟΝΑ 32 

 

Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο: Τοποθετήστε έξι εικόνες στη γραμμή Video 1. Η διάρκεια προβολής της 
κάθε εικόνας θα είναι 15 δευτερόλεπτα. 
Βήμα 2ο: Ανοίξτε το φάκελο Video Effects της καρτέλας Effects και επεξεργαστείτε 
όλα τα αρχεία που υπάρχουν μέσα σε αυτόν. 
Βήμα 3ο:  Επιλέξτε 6 αρχεία οπτικών εφέ, για να τα τοποθετήσετε σε κάθε εικόνα. 
Τα αρχεία αυτά θα τα τοποθετήσετε μέσα σε ένα φάκελο τον οποίο θα έχετε ήδη 
δημιουργήσει. 
Βήμα 4ο: ∆ημιουργήστε τις δικές σας παρουσίαση των εικόνων μετά ειδικά εφέ που 
θα έχετε τοποθετήσει σε κάθε εικόνα. 
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∆ραστηριότητα 6η:   
∆ημιουργία τίτλων 

 
α. Γενικά 
 
Η δραστηριότητα αφορά το χειρισμό βασικών εντολών για την είσοδο τίτλων σε 
μια εικόνα, καθώς και σε κάθε εικόνα που υπάρχει στήν γραμμή Video 1. 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ενότητες: ∆ημιουργία τίτλων Των 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να γνωρίζει το περιβάλλον εργασίας του λογισμικού Adobe Premier Pro CS3 
 Να εξοικειωθεί με το περιβάλλον του Adobe Premier Pro CS3. 
 Να γνωρίσει πως μπορεί να εισάγει τίτλους σε μια εικόνα. 
 Να γνωρίσει την περιοχή εντολών. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 

 
Ρόλος ομάδας επιμορφούμενων 
Στην εισαγωγική αυτή δραστηριότητα γίνεται η γνωριμία των μελών των ομάδων 
μεταξύ τους. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
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Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την εισαγωγή των τίτλων. 
 Ηλεκτρονικό βοηθητικό υλικό 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
Για να μειώσετε το παράθυρο επικοινωνίας των τίτλων, πηγαίνετε στην τη γραμμή 
εργαλείων και επιλέγεται: 

Title > New Title > Based on Template 
Οπότε παρατηρείτε ότι σας ανοίγει ένα καινούργιο παράθυρο όπως αυτό που 
βλέπετε στην εικόνα 33. 
 

 
ΕΙΚΟΝΑ 33 

 
Το παράθυρο των τίτλων αποτελείται από 5 πάνελ, τα οποία είναι: 
Το κύριο πάνελ του Titler που βρίσκεται στο κέντρο της εικόνας και πάνω σε αυτό 
των υπάρχουν τα πλαίσια μέσα στα οποία θα γραφεί το κείμενο. Σε αυτό πάνελ 
γίνονται όλες οι εργασίες για την εισαγωγή και την διαμόρφωση των τίτλων. 
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Το πάνελ Title Tools περιέχει μία σειρά εργαλείων τα οποία είναι χρήσιμα για τη 
δημιουργία της μορφής και της κατεύθυνσης που θα έχει το κείμενο. Επίσης σας 
δίνει τη δυνατότητα να εισάγεται διάφορα κείμενα. 
Το πάνελ Title Action ασχολείται για την τελική διαμόρφωση και θέση που θα 

καταλάβει το κείμενο μέσα στην εικόνα. 
Το πάνελ Title Properties, στο οποίο γίνονται όλες 
οι επιλογές για τη διαμόρφωση το χαρακτηριστικών 
της γραμματοσειράς. Επίσης μπορείς να αλλάξεις το 
μέγεθος του χώρου τον οποίο καταλαμβάνει το 
κείμενο. 
Το πάνελ Title Styles εισάγει το στυλ της 
γραμματοσειράς, από μια σειρά προκαθορισμένων 
γραμματοσειρών που υπάρχουν στις βιβλιοθήκες το 
λογισμικού. 
 
Εισαγωγή τίτλων 
Για να γράψετε έναν τίτλο διαλέγετε την 
κατεύθυνση που θέλετε να έχει το κείμενο από τα 
εργαλεία κείμενο του πάνελ Title Tools. Στη 
συνέχεια έρχεστε μέσα στο χώρο που πρέπει να 
γράφει το κείμενο και κάνατε αριστερό κλικ. 
Βλέπετε ότι δημιουργείται μια μπάρα, η κατεύθυνση 
της έχει σχέση με την κατεύθυνση που επιλέξατε 

από τη γραμμή εργαλείων. Οπότε αρχίζετε να πληκτρολογείτε το κείμενο. 
Με τον τρόπο αυτό έχετε δημιουργήσει τον τίτλο που θέλετε να χρησιμοποιήσετε. 
Για να επιλέξετε το στυλ των γραμμάτων, πηγαίνετε στο πάνελ Title Styles και 
επιλέγεται ένα από τα πολλά στυλ που υπάρχουν. 
 

 
ΕΙΚΟΝΑ 35 

 
Εάν θέλετε να μεγαλώσουν ή να μικρύνουν τα γράμματα, πηγαίνετε στο πάνελ 
Title Properties και ανοίγεται το φάκελο Transform. Πηγαίνετε τον κέρσορα του 
ποντικιού πάνω στο νούμερο του πλάτους (Width) και κάνοντας αριστερό κλικ, 
μπορείτε να επιλέξετε το πλάτος που εσείς θέλετε. Το ίδιο μπορεί να γίνει και με το 
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ύψος (Height). Με αυτό τον τρόπο μεταβάλλεται το ύψος και το πλάτος και 
επομένως αλλάζει και το μέγεθος των γραμμάτων. 
Σε μια εικόνα μπορείτε να πάρετε και περισσότερους από έναν τίτλους, 
διαφορετικής κατεύθυνσης ο καθένας, όπως φαίνεται στην εικόνα 35. Εκτός από 
γράμματα μπορείτε να εισάγεται και διάφορα σχήματα τα οποία επιλέγεται από τα 
εργαλεία σχημάτων του πάνελ Title Tools. Το μέγεθος των σχημάτων το επέλεγε 
εσείς. 
Για να κεντράρετε το κείμενο, πηγαίνετε στο πάνελ Title Action και με τη βοήθεια 
των εικονιδίων κεντραρίσματος (Center) επιλέγεται την κατεύθυνση κατά την 
οποία θέλετε να το κεντράρετε. 
Εάν θέλετε να αλλάξετε τη γραμματοσειρά, πηγαίνετε πάνελ Title Properties και 
μέσα από τη λίστα Font Family (οικογένεια γραμματοσειρών), επιλέγετε τη 
γραμματοσειρά που εσείς θέλετε. 
 
Πρότυπα τίτλων 
Το λογισμικό διαθέτει μια σειρά από πρότυπα τα οποία θα σας βοηθήσουν να 
δημιουργήσετε τίτλος οι οποίοι σαν υπόβαθρο δεν θα έχουν την εικόνα αλλά 
κάποια εικόνα αντίστοιχη της ενότητας του τίτλου. 
Για να μπορέσετε να ενεργοποιήσετε τα πρότυπα, Πηγαίνετε στην γραμμή 
εργαλείων και ακολουθείται μια από τις παρακάτω διαδικασίες: 

Title > Templates 
ή 

Title > New Title > Based On Template 
Στην οθόνη σας θα εμφανισθεί ένα εικονίδιο το οποίο θα περιέχει όλες τις 
κατηγορίες των προεπιλεγμένων τίτλων (εικόνα 36). Κάθε κατηγορία περιέχει μια 
σειρά από αρχεία με διαφορετικούς τίτλους το καθένα. 
 

 
ΕΙΚΟΝΑ 36 

 
Κάθε φορά που επιλέγεται κάποια αρχείο στο δεξί μέρος θα εμφανίζεται η εικόνα 
και ο τρόπος με τον οποίον είναι διαρθρωμένος ο τίτλος, όπως βλέπετε στην 
εικόνα 37. 
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ΕΙΚΟΝΑ 37 

 
Επιλέγοντας το πλήκτρο ΟΚ, τότε εμφανίζεται η εικόνα 37 όπου η μορφή που 
επιλέξατε έρχεται στο πάνελ του Titler. Βλέπετε ότι εκτός από τον κυρίως τίτλο, 
υπάρχει και μια σειρά από υπότιτλους. Από τους υπότιτλους χρησιμοποιείται 
όποιους θέλετε και τους υπόλοιπους τους σβήνετε (εικόνα 38). 
 

 
ΕΙΚΟΝΑ 38 

 
Εφέ τίτλων 
Στην αρχή του μαθήματος αναφέρθηκε ότι οι τίτλοι μπορούν να μην είναι 
διατεταγμένοι σε οριζόντια ή κάθετη γραμμή αλλά να μπορούν και να έχουν 
κάποια καμπύλη. 
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Για να επιλέξετε κάποιο τίτλο ο οποίος δεν θα είναι γραμμένος σε ευθεία γραμμή 
αλλά θα ακολουθεί κάποια καμπύλη γραμμή, όπως εικονίζετε στην εικόνα 39, θα 
ακολουθήσετε την παρακάτω διαδικασία. 

 
ΕΙΚΟΝΑ 39 

 
Από τα εργαλεία κειμένου επιλέγεται το εργαλείο Path Type το οποίο το κάνουμε 
αριστερό κλικ και το σύρετε σε οποιοδήποτε σημείο της εικόνας θέλετε. θα 
παρατηρήσετε ότι στην οθόνη εμφανίζεται μια γραμμή πάνω στην οποία πρόκειται 
να γραφεί ο τίτλος. 
Με τη βοήθεια των εργαλείων πένας μπορείτε να σύρεται τις λαβές (οι κουκίδες 
στα άκρα της γραμμής) και να επιμηκύνεται είναι μικρύνετε τις γραμμές. Η 
καμπύλη γραμμή δημιουργείται με τη μετακίνηση του σημείου ορισμού. 
Για να γράψετε το κείμενο του τίτλου, αρκεί να κάνετε αριστερό κλικ σε 
οποιοδήποτε σημείο κοντά στη γραμμή. Οπότε εμφανίζεται η μπάρα κειμένου και 
αρχίζετε να πληκτρολογείτε το κείμενο. 

 
ΕΙΚΟΝΑ 40 
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Εργαλεία σχεδίασης σχημάτων 
Επιλέγετε το εργαλείο σχημάτων που θέλετε και δημιουργείται ένα σχήμα μέσα 
στην οθόνη. Αφού δημιουργήσατε το σχήμα πηγαίνετε μέσα σε αυτό και κάνατε 
αριστερό κλικ για να μπορείτε να γράψετε το κείμενο (εικόνα 40). 
 
Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο: ∆ημιουργήστε έναν τίτλο πάνω σε μια εικόνα που ήδη έχετε. Ο τίτλος 
αυτός, θα έχει φορά από κάτω αριστερά προς πάνω δεξιά. 
Βήμα 2ο: Άνοιξε μια άλλη εικόνα και δημιούργησε έναν τίτλο πάνω σε μια καμπύλη 
γραμμή, η οποία θα ξεκινά από αριστερά προς τα δεξιά και το μέσο της θα είναι 
προς τα επάνω. 
Βήμα 3ο:  Άνοιξε το αρχείο πρότυπου τίτλου «Lower Third 1026» και γράψε ως 
τίτλο το ονοματεπώνυμό σου. 
Βήμα 4ο: ∆ημιούργησε έναν κυλιόμενο τίτλο, από κάτω προς τα επάνω, ο οποίος 
θα περιέχει 15 γραμμές. 
Βήμα 5 Τα τα χαμένα παιδιά 7 δρχ. ο: ∆ημιούργησε μια ταινία τα πέντε εικόνες ή 
πέντε βιντεοκλίπ και προσθέστε από έναν διαφορετικό τίτλο για κάθε εικόνα ή 
βιντεοκλίπ. 
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∆ραστηριότητα 7η:   
Επεξεργασία ήχου 

 
α. Γενικά 
 
Η δραστηριότητα αφορά το χειρισμό βασικών εντολών για την είσοδο αρχείων 
ήχου καθώς και την εγγραφή ήχου με τη βοήθεια ενός μικροφώνου. Η παραπάνω 
είχε θα επεξεργάζονται, θα εξετάζονται τα χαρακτηριστικά τους και θα 
μοντάρονται. 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ενότητες: Επεξεργασία ήχου 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να γνωρίζει το περιβάλλον εργασίας του λογισμικού Adobe Premier Pro CS3 
 Να εξοικειωθεί με το περιβάλλον του Adobe Premier Pro CS3. 
 Να γνωρίσει πως εισάγονται οι ήχοι που θα χρησιμοποιηθούν για μια ταινία. 
 Να μπορεί να προσθέτει εφέ ήχου στην ταινία. 
 Να γνωρίσει την περιοχή εντολών για τους ήχους των . 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 
 
Ρόλος ομάδας επιμορφούμενων 
Τα μέλη της ομάδας έρχονται σε μια πρώτη επαφή με το αντικείμενο με το οποίο 
θα ασχοληθούν στην παρούσα δραστηριότητα 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
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Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
 
Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία του ήχου. 
 Ηλεκτρονικό βοηθητικό υλικό 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
Η επεξεργασία του ήχου στο συγκεκριμένο λογισμικό μπορεί να γίνει με μεγάλη 
ακρίβεια. Συγκεκριμένα κατά το μοντάζ, ο ήχος οποίος προέρχεται από CD στο 
οποίο τα δείγματα είναι 44100 δείγματα ανά δευτερόλεπτο, η επεξεργασία μπορεί 
να γίνει στο ρυθμό του δήγματος. Συγκεκριμένα μπορεί να κάνει επεμβάσεις 
ανάμεσα σε δύο δείγματα. 
Έχει τρία κανάλια ήχου, τα οποία είναι: 
 Το μονοφωνικό κανάλι ήχου. 
 Το στερεοφωνικό κανάλι ήχου. 
 Το εξακάναλο κανάλι ήχου (5.1 κανάλια). 
Εκτός από τα παραπάνω έχει τη δυνατότητα να πάρει το κάθε κανάλι από το 
στερεοφωνικού χωριστά, καθώς και τα κανάλια του εξακάναλου. Με αυτό τον 
τρόπο, μπορεί να απομονώσει ήχους και να τους χρησιμοποιήσει χωριστά το 
καθένα από αυτούς. 
Αν η ταινία έχει χαρακτηριστικά ήχου 48.000, όπως προαναφέρεται στη 
δραστηριότητα 1, τότε θα διαπιστώσετε ότι έχει καλύτερα χαρακτηριστικά 
ανάλυσης απ’ ότι ένα CD. 
 
Επεξεργασία αρχείων ήχου. 
Ανοίξτε το λογισμικό Adobe Premiere Pro CS3 και εισάγεται ορισμένα αρχεία ήχου, 
στο πάνελ Project. Επιλέξτε ένα αρχείο μονοφωνικού ήχου, και κάντε διπλό κλικ 
πάνω σε αυτό. Επιλέξτε Show Audio Time Units και θα δείτε ότι στο πάνελ Source 
εμφανίζεται το σχήμα της εικόνας 41. Στο χάρακα χρόνου θα δείτε ότι δεν 
υπάρχουν δευτερόλεπτα ή καρέ αλλά οι υποδιαιρέσεις είναι σε δείγματα ήχου. 
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ΕΙΚΟΝΑ 41 

 
Για να δείτε την δυνατότητα ανάλυσης που έχει το πρόγραμμα, αρκεί να εισάγετε 
και τους τρεις τύπους καναλιών στο πάνελ Project, με τον ίδιο τρόπο που γίνεται 
και για τις εικόνες. 
Για να εισάγετε κάποιο από αυτά τα αρχεία στο πάνελ Source, αρκεί να κάνετε δεξί 
κλικ πάνω στο αρχείο. Επιλέξτε την εντολή Open in Source Monitor και θα δείτε 
ότι θα εμφανιστεί το ακουστικό διάγραμμα.  
Αν θέλετε να δείτε μόνο ένα μικρό μέρος του διαγράμματος σε μεγέθυνση, αρκεί 
να σύρετε την αριστερή λαβή της μπάρας της περιοχής εξέτασης προς τα δεξιά. 
Αυτό θα έχει σαν αποτέλεσμα να δείτε την αρχή του ακουστικού σήματος, όπως 
φαίνεται στην εικόνα 42. 
 

 
ΕΙΚΟΝΑ 42 
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Αν αντί για μονοφωνικό κανάλι ήχου εισάγεται ένα στερεοφωνικό κανάλι ήχου, 
τότε θα δείτε ότι εμφανίζεται το σχήμα της εικόνας 43. Στο σχήμα αυτό βλέπετε 
ότι υπάρχον δύο κανάλια αντί του ενός που υπήρχε στο προηγούμενο σχήμα. 
 

 
ΕΙΚΟΝΑ 43 

 
Αν θέλετε να δείτε κάποιο εξακάναλο σήμα, τότε θα πρέπει να επιλέξετε ώστε να 
παρουσιάζονται όλα τα κανάλια αυτού. Αυτό γίνεται, πηγαίνοντας στη γραμμή 
εργαλείων και επιλέγοντας: 

Edit > Preferences > Audio 
Στο παράθυρο που ανοίγει, εμφανίζονται οι παρακάτω επιλογές: 
 Front Only: Ο ήχος παρουσιάζεται μόνο στα δύο μπροστινά κανάλια. 
 Front + Rear: Ο ήχος παρουσιάζεται στα δύο μπροστινά και στα δύο πίσω 

κανάλια. 
 Front + LFE: Ο ήχος παρουσιάζεται στα δύο μπροστινά κανάλια και στα 

κανάλια για τα εφέ των χαμηλών συχνοτήτων. 
 Front + Rear + LFE: Ο ήχος παρουσιάζεται σε όλα τα κανάλια. 
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ΕΙΚΟΝΑ 44 

 
Για να διαχωρίσετε τα κανάλια του εξακάναλου ακουστικού σήματος κα να πάρετε 
το κάθε κανάλι χωριστά, αρκεί να κάνετε διπλό κλικ στο συγκεκριμένο αρχείο. Στη 
συνέχεια πηγαίνετε στην γραμμή εργαλείων και επιλέγετε τις εντολές: 

Clip > Audio Options > Breakout To Mono 
Αυτό θα έχει σαν αποτέλεσμα να διαχωριστεί ο ήχος σε έξι μονοφωνικά αρχεία 
ήχου (εικόνα 45). 
 

 
ΕΙΚΟΝΑ 45 

 
Αν θελήσετε να σύρετε το εξακάναλο αρχείο ήχοι στο ∆ιάγραμμα Ροής Χρόνου, και 
συγκεκριμένα στη γραμμή Audio 1, θα διαπιστώσετε ότι αυτό δεν μπορεί να μπει 
στην συγκεκριμένη γραμμή, αλλά θα δημιουργηθεί μια νέα, η γραμμή Audio 4 
(εικόνα 46). Αυτό συμβαίνει γιατί τα κανάλια Audio 1, Audio 2 και Audio 3 είναι 
στερεοφωνικά. Πηγαίνοντας σε κάθε μια από τις παραπάνω γραμμές και πατώντας 
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το τρίγωνο που βρίσκεται στην αριστερή πλευρά, τότε θα διαπιστώσετε το 
παραπάνω, εφ’ όσον βλέπετε ότι το καθένα από αυτά έχει τις ενδείξεις L και R (Left 
και Right), όπως βλέπετε και στην εικόνα 46. 
 

 
ΕΙΚΟΝΑ 46 

 
∆ιαγραφή καναλιών ήχου και εικόνας 
Αν θέλετε να διαγράψετε κάποια κανάλια από το ∆ιάγραμμα Ροής Χρόνου, που δεν 
θα χρησιμοποιήσετε, αυτό μπορείτε να το κάνετε με τον ακόλουθο τρόπο: 
Κάνετε αριστερό κλικ σε ένα από τα 
κανάλια. 
Επιλέγετε την εντολή «Delete 
Tracks», οπότε εμφανίζεται το 
παράθυρο διαλόγου της εικόνας 47. 
 Τσεκάρετε τα τετράγωνα: 
 Delete Audio Tacks στο πλαίσιο 

Audio Tacks και επιλέγετε το All 
Empty Tracks 

 Delete Video Tacks στο πλαίσιο 
Video Tacks και επιλέγετε το All 
Empty Tracks 

Αυτό θα έχει σαν αποτέλεσμα, να 
σβήσουν όλα τα κανάλια, εκτός από 
ένα κανάλι Video και το κανάλι ήχου 
που χρησιμοποιείται, όπως φαίνεται 
στην εικόνα 48. 
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ΕΙΚΟΝΑ 48 

 
Ηχητικά εφέ 
Επιλέξτε το μονοφωνικό κανάλι για να δημιουργήσετε διάφορα εφέ πάνω σε αυτό. 
Με τον τρόπο που αναφέρθηκε παραπάνω, σβήνετε τα κανάλια που δεν 
χρειάζεστε. Στο πάνελ Effects επιλέγετε: 

Audio Effects > Mono > Delay 
Παίρνετε το Delay και το σύρετε πάνω στο αρχείο ήχου, στο ∆ιάγραμμα Ροής 
Χρόνου. Ανοίγετε το πάνελ Effect Controls και κάνετε δεξί κλικ σε όλους τους 
τριγωνικούς μηχανισμούς. Αυτό θα έχει σαν αποτέλεσμα να εμφανιστούν όλοι οι 
παράμετροι που υπάρχουν, όπως φαίνεται στην εικόνα 49. 
 

 
ΕΙΚΟΝΑ 49 
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Υπάρχουν τρεις κλίμακες, οι οποίες είναι: 
 Delay: ∆ηλώνει τον χρόνο μετά από τον οποίο αρχίζει να αναπαράγεται η 

ηχώ. Αυτός ο χρόνος διαρκεί από 0 έως 2 δευτερόλεπτα. 
 Feedback: ∆ηλώνει το ποσοστό της ηχούς, το οποίο προστίθεται στον ήχο. 
 Mix: ∆ηλώνει την σχετική ένταση της ηχούς, ως προς τον ήχο, σε ποσοστό επί 

τοις εκατό. 
Με τον ίδιο τρόπο εργάζεστε και για τους άλλους τύπους ήχου (εξακάναλος ή 
στερεοφωνικός ήχος). 
 
Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο:  Εισάγεται και τους τρεις τύπους καναλιών, στις γραμμές ήχου με την 
ακόλουθη σειρά: 
 Στο κανάλι Audio 4 βάλτε το αρχείο με τον εξακάναλο ήχο. 
 Στο κανάλι Audio 5 βάλτε το αρχείο με τον μονοφωνικό ήχο. 
 Στο κανάλι Audio 1 βάλτε το αρχείο με τον στερεοφωνικό ήχο. 
 
Βήμα 2ο: Προσθέστε το εφέ Delay και στα τρία κανάλια και ρυθμίστε με τον 
ακόλουθο τρόπο: 
 Το κανάλι Audio 4 θα έχει Delay=0,500, Feedback=30% και Mix=50%. 
 Το κανάλι Audio 5 θα έχει Delay=1,500, Feedback=60% και Mix=25%. 
 Το κανάλι Audio 1 θα έχει Delay=1,000, Feedback=50% και Mix=75%. 
 
Βήμα 3ο:  Μετακινήστε τα αρχεία ήχου, στο ∆ιάγραμμα Ροής Χρόνου, ούτως ώστε 
το δεύτερο να ξεκινάει εκεί που τελειώνει το πρώτο. Η σειρά είναι αυτή που 
αναφέρεται πιο πάνω. 
 
Βήμα 4ο: αναπαράγετε τον ήχο. 
 
Βήμα 5ο:  Επαναλάβετε τα παραπάνω βήματα, άλλες δύο φορές, χρησιμοποιώντας 
διαφορετικά εφέ για κάθε κανάλι. 
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∆ραστηριότητα 8η:   
Επεξεργασία έτοιμου βίντεο 

 
α. Γενικά 
 
Η δραστηριότητα αφορά το χειρισμό βασικών εντολών για την μετακίνηση της 
εικόνας του βίντεοκλιπ, καθώς αυτό αναπαράγεται. 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ενότητες: Επεξεργασία έτοιμου βίντεο 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να κάνει διάφορα εφέ που αφορούν την κίνηση της εικόνας. 
 Να εξοικειωθεί με το περιβάλλον των εφέ κίνησης του Adobe Premier Pro CS3. 
 Να μπορεί να δημιουργεί ταινία με εφέ κίνησης. 
 Να γνωρίσει την περιοχή εντολών. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 

 
Ρόλος ομάδας επιμορφούμενων 
Οι επιμορφούμενοι έχουν μάθει τις απλές εντολές και συνεργάζονται για τη 
δημιουργία μιας ταινίας με περισσότερο σύνθετα και φαντασμαγορικά εφέ. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
Έχει την αρμοδιότητα της εύρεσης των βιντεοκλίπ, πάνω στα οποία θα εργαστούν. 
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Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
 Ηλεκτρονικό βοηθητικό υλικό 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
Στο κεφάλαιο αυτό θα ασχοληθείτε με την δημιουργία κίνησης στην προβολή της 
εικόνας. Αυτή θα μετακινείται οριζόντια, όπως θα την ορίσετε εσείς. 
Για να μπορέσετε να εργασθείτε καλύτερα, θα μικρύνετε το μέγεθος της οθόνης 
ανοίγοντας την λίστα View Zoom Level στο μόνιτορ Programs (εικόνα 50). Η 
εικόνα θα μικρύνει και θα καταλάβει ένα σημείο, όπως βλέπετε. 
 

 
ΕΙΚΟΝΑ 50 

 
Εισάγετε ένα βιντεοκλίπ και ανοίγετε το Effects Control. Κάνοντας δεξί κλικ πάνω 
στο βιντεοκλίπ που βρίσκεται στο ∆ιάγραμμα Ροής Χρόνου, θα εμφανιστεί το εφέ 
Motion. Ανοίγοντας τον τριγωνικό μηχανισμό του Motion, θα εμφανιστούν οι 
παράμετροί του. Στο Position βλέπετε τις τιμές 360 και 288, αυτές αντιστοιχούν 
στο μισό του Frame Size (720 και 576) που αντιστοιχεί στο σύστημα PAL. 
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Για να ενεργοποιήσετε τα καρέ κλειδιά, ενεργοποιήστε το Position και κάντε δεξί 
κλικ στο Toggle Animation. Στη συνέχεια κάντε δεξί κλικ στο Reset του Motion. Με 
αυτό τον τρόπο επαναφέρετε την εικόνα στις προεπιλεγμένες ρυθμίσεις τους. 
Έχοντας την ένδειξη CTI στην αρχή του βιντεοκλίπ, κάνετε κλικ στην εικόνα που 
βρίσκεται στο Program. Θα δείτε ότι εμφανίζεται ένα λευκό περίγραμμα γύρω από 
την εικόνα και στο κέντρο του ένα σταυρόνημα. 
Μετακινώντας την εικόνα, βλέπετε ότι οι συντεταγμένες της θέσης Position 
αλλάζουν. Όταν το σταυρόνημα βρίσκεται στην πάνω αριστερή γωνία οι 
συντεταγμένες δείχνουν 0,0 και 0,0 ενώ όταν είναι στην κάτω δεξιά γωνία 
παίρνουν την μέγιστη τιμή, που για το σύστημα PAL είναι 720,0 και 576,0. 
 
∆ημιουργία εφέ κίνησης της εικόνας 
Για να δημιουργήσετε εφέ κίνησης της ταινίας, όπου η ταινία θα μετακινείται πάνω 
στην οθόνη και δε εμφανίζεται μέρος αυτής ή ολόκληρη η ταινία, σύρεται με τη 
βοήθεια του ποντικιού, την ταινία και τι βγάζετε έξω από το αριστερό πλαίσιο της 
οθόνης, όπως φαίνεται και στην εικόνα 51. 

 

 
ΕΙΚΟΝΑ 51 

 
Για να δημιουργήσετε την κίνηση που εσείς θέλετε, φέρεται το CTI στην αρχή του 
βιντεοκλίπ και στη συνέχεια πατάτε το κουμπί PageUp. Με αυτό τον τρόπο 
δημιουργήσατε το πρώτο σημείο στο Toggle Animation. 
Στη συνέχεια μετακινείται το CTI στο σημείο που εσείς θέλετε, κατά τη διάρκεια 
του βιντεοκλίπ και μετακινείται το πλαίσιο, δημιουργώντας έτσι το δεύτερο σημείο 
στο Toggle Animation. Αυτό σημαίνει ότι η ταινία θα μετακινηθεί από το 
προηγούμενο σημείο σε αυτό διανύοντας το συγκεκριμένο κομμάτι του βιντεοκλίπ. 
Με αυτό τον τρόπο μπορείτε να δημιουργήσετε σε άλλα σημεία του Toggle 
Animation που θα ορίζουν την κίνηση της ταινίας. Η κίνηση αυτή μπορεί να είναι 
ευθύγραμμη ή και καμπύλη. 
Όταν φτάσετε το CTI στο τέλος του βιντεοκλίπ, και μετακινήσετε την εικόνα στο 
σημείο που εσείς θέλετε να τελειώσει, τότε πατάτε το κουμπί Page Down και το 
αριστερό βέλος. 
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Για να δείτε την αναπαραγωγική της έννοιας αρκεί να πατήσετε το Spacebar. Με το 
ίδιο πλήκτρο, μπορείτε να σταματήσετε και αναπαραγωγή της ταινίας. 
 
∆ημιουργία εφέ περιστροφής της εικόνας 
Για να κάνατε την εικόνα να περιστρέφεται γύρω από το κέντρο της, καθώς 
προβάλλεται η ταινία, αρκεί να ακολουθήσετε την παρακάτω διαδικασία. 
Πηγαίνετε το CTI στην αρχή του βιντεοκλίπ Στο πάνελ Effect Controls 
ενεργοποιείται τις επιλογές Position, Scale και Rotate. Στη συνέχεια, 
ενεργοποιείται το κουμπί Go To Next Keyframe, Όπως φαίνεται και στην εικόνα 
52.  
 

 
ΕΙΚΟΝΑ 52 

 
Μετακινήστε το CTI στο δεύτερο καρέ. Πλησιάζετε τον κέρσορα σε μια από τις 
λαβές του πλαισίου της εικόνας μέχρις ότου αυτός πάρει το σχήμα ενός καμπύλου 
τόξου με βελάκια στις δύο άκρες του. Όταν εμφανισθεί αυτό, τότε πιέζετε το 
αριστερό κλικ του ποντικιού και κρατώντας πατημένο το κουμπί, περιστρέφεται το 
πλαίσιο της ταινίας προς την κατεύθυνση που εσείς θέλετε να και κατά τη γωνία 
που εσείς θέλετε. 
Επαναλαμβάνετε αυτή την ενέργεια για όσες φορές θέλετε. Όσο μικρότερη είναι η 
μετακίνηση του CTI και όσο μεγαλύτερη είναι η περιστροφή της εικόνας, τόσο πιο 
γρήγορα θα περιστρέφεται η εικόνα. Μπορείτε να κάνετε την εικόνα να κάνει 
περιστροφή μεγαλύτερη από έναν πλήρη κύκλο. 
Όταν φτάσετε το CTI στο τέλος του βιντεοκλίπ, τότε πατήστε το κουμπί Page 
Down και το αριστερό βέλος. Με τη βοήθεια του Spacebar, αναπαράγετε την 
ταινία. 
Στην εικόνα 53 βλέπετε πως θα εμφανίζεται η ταινία, σε κάποια σημεία της 
περιστροφής της. 
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ΕΙΚΟΝΑ 53 

 
Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο:  Ανοίξετε  έναν νέο Project και εισάγεται μέσα σε αυτό δύο βιντεοκλίπ. 
Σύρετε το ένα απ' αυτά στο διάγραμμα ροής χρόνο και δημιουργήστε διάφορα εφέ 
με το συγκεκριμένο βιντεοκλίπ. 
Βήμα 2ο: Βάλτε και τα δύο βιντεοκλίπ στο διάγραμμα ροής χρόνο τα οποία θα 
ξεκινά με την ίδια χρονική στιγμή (Video 1 και 2). ∆ημιουργήστε διαφορετικό εφέ 
κίνησης στο καθένα από αυτά. Αναπαράγετε την ταινία και συζητήστε με τους 
άλλους επιμορφούμενους, τα αποτελέσματα αυτής της ενέργειας. 
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∆ραστηριότητα 9η:   
Μεταφορά της ταινίας σε μέσο αναπαραγωγής 

 
α. Γενικά 
 
Η δραστηριότητα αφορά το χειρισμό βασικών εντολών για την μεταφορά της 
ταινίας σε κάποιο DVD ή άλλο μέσο αναπαραγωγής. . 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

Μάθημα: Παραγωγή και Επεξεργασία σήματος 

∆ιδακτικές ενότητες: Μεταφορά της ταινίας σε μέσο αναπαραγωγής 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να γνωρίζει τον τρόπο μεταφοράς μιας ταινίας. 
 Να γνωρίζει όλους τους τρόπους εξαγωγής μιας ταινίας και να επιλέγει το 
κατάλληλο ανάλογα με το μέσο στο οποίο φέρεται να μεταφέρει αυτή. 

 Να γνωρίζει τι επιλογές έχει ανάλογα με το που θα μεταφέρει την ταινία. 
 Να γνωρίσει την περιοχή εντολών. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 

 
Ρόλος ομάδας επιμορφούμενων 
Στην περίπτωση αυτή, οι επιμορφούμενοι συζητούν μεταξύ τους για τον τρόπο που 
θα εξάγουν μια ταινία και το μέσο στο οποίο θα εξάγουν αυτή. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του Adobe 
Premier Pro CS3. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
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Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
 Ηλεκτρονικό βοηθητικό υλικό 
Λογισμικά: Adobe Premier Pro CS3, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
Για την εξαγωγή μιας ταινίας, πηγαίνετε στη γραμμή εργαλείων και επιλέγετε: 

File > Export 
Όπως φαίνεται και στην εικόνα 54, οι επιλογές που έχετε είναι οι παρακάτω: 

 
ΕΙΚΟΝΑ 54 

 Movie: η επιλογή αυτή δημιουργεί αρχεία βίντεο σε μορφή AVI. 
 Frame: μετατρέπει κάποιο καρέ που έχετε επιλέξει σε στατική εικόνα η οποία 

έχει τη μορφή αρχείων BMP, GIF, TIFF ή Targa. 
 Audio: μπορεί να γράψει ένα αρχείο ήχου σε μορφή αρχείων WAV, AVI ή 

QuickTime. 
 Title: η επιλογή αυτή εγγράφει κάποια αρχεία τίτλων, τα οποία έχουν 

δημιουργηθεί και για έχουν αποθηκευθεί χωριστά. 
 Export to Tape: εξάγει το έργο σε βιντεοταινία. 
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 Export to Encore: αποστέλλει το έργο από το Adobe Premiere Pro CS3 στο 
Adobe Encore CS3. 

 Export to EDL: προετοιμάζει το έργο η για να επεξεργασθεί περαιτέρω σε ένα 
στούντιο παραγωγής. 

 Adobe Clip Notes: δημιουργεί ένα αρχείο με τη βοήθεια του οποίου μπορεί 
κάποιος να επεξεργασθεί το έργο. 

 Adobe Media Encoder: Μπορεί να μεταφέρει ολόκληρο το έργο ή ένα μέρος 
από αυτό σε μορφή υψηλού επιπέδου, όπως MPEG, Windows Media,RealMedia 
ή QuickTime. 

 
Επιλογές εξαγωγής μιας ταινίας 
Αρχικά θα επιλέγετε το βιντεοκλίπ μου θέλετε να εξάγετε και στη συνέχεια, από τη 
γραμμή εργαλείων επιλέγετε τις εντολές: 

File > Export > Movie 
Στην οθόνη σας εμφανίζετε η εικόνα 55. 

 
ΕΙΚΟΝΑ 55 

Στο εικονίδιο Export Movie Settings, έχετε τέσσερις επιλογές ρύθμισης, οι οποίες 
είναι: 
 Η επιλογή General, όπου στο File Type έχετε τις επιλογές δεν εμφανίζονται 

στην κοινή εικόνα 55. Οι επιλογές που έχετε στην κατηγορία General είναι: 
 File Type: Υπάρχουν δώδεκα τύποι αρχείων για την επιλογή του τύπου 

εξαγωγής. Ορισμένα από αυτά είναι μόνο για εξαγωγή αρχείων ήχου και 
όχι εικόνων. 

 Range: Σας δίνει τη δυνατότητα να εξάγετε ολόκληρο το βιντεοκλίπ ή 
μέρος αυτού. 

 Embedding Options: Έχετε την επιλογή να ενσωματώσετε μια σύνδεση για 
την ταινία που θα εξάγετε. 
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 Η επιλογή Video, στην οποία μπορείτε να κάνετε τις ρυθμίσεις των 
παραμέτρων που αντιστοιχούν στο σύστημα εικόνας που θα χρησιμοποιήσετε. 
Οι παράμετροι αυτοί εμφανίζονται στην εικόνα 56. 

 

 
ΕΙΚΟΝΑ 56 

 
 Η επιλογή Keyframe and Rendering, στην οποία μπορείτε να κάνετε τις 

ρυθμίσεις των παραμέτρων που εμφανίζονται στην εικόνα 57. 
 

 
ΕΙΚΟΝΑ 57 
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 Η επιλογή Audio, στην οποία μπορείτε να κάνετε τις ρυθμίσεις των 
παραμέτρων του ήχου που εμφανίζονται στην εικόνα 58. 

 

 
ΕΙΚΟΝΑ 58 

 
Επιλογές εξαγωγής μόνο ήχου 
Αν θέλετε να γράψετε μόνο τον ήχο και όχι την εικόνα, τότε από την γραμμή 
εργαλείων επιλέγετε: 

File > Export > Audio 
και εμφανίζετε το παράθυρο διαλόγου , όπως φαίνεται στην εικόνα 59. 
 

 
ΕΙΚΟΝΑ 59 
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Από τις κατηγορίες του παράθυρου διαλόγου, επιλέγετε την General και στην 
κατηγορία File Type (εικόνα 60), επιλέγετε την Windows Waveform, η οποία είναι 
και η καλύτερη για την εξαγωγή αρχείων ήχου. 
 

 
ΕΙΚΟΝΑ 60 

 
Στην κατηγορία επιλογών Audio, 
 

 
ΕΙΚΟΝΑ 61 
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Στην επιλογή του Sample Rate, εκτός από την επιλογή των 48000 Hz (16-bit) και 
των 32000 Hz (12-bit), υπάρχει και η επιλογή 44100 Hz που δηλώνουν την 
συχνότητα δειγματοληψίας των CD ήχου. 
 
Το Adobe Media Encoder 
Το Adobe Media Encoder μπορεί να υποστηρίξει τις περισσότερες μηχανές 
κωδικοποίησης, όπως: 
 MPEG 
 Windows Media 
 Adobe Flash Video  
 Real Media  
 Quick Time 
Η διαδικασία που ακολουθείται για την εξαγωγή ταινίας με την χρήση του Adobe 
Media Encoder, μέσω της γραμμής εργαλείων, είναι η ακόλουθη: 

File > Export > Adobe Media Encoder 
Οπότε στην οθόνη εμφανίζεται το παράθυρο του Adobe Media Encoder (εικόνα 
62), το οποίο χωρίζεται σε δύο μέρη: 
 

 
ΕΙΚΟΝΑ 62 

 
 Στο Adobe Media Encoder και στο αριστερό του μέρος, υπάρχει η περιοχή 

προεπισκόπησης, όπου βλέπετε την ταινία που πρόκειται να εξάγετε. 
 Στο δεξιό τμήμα του Adobe Media Encoder, υπάρχει ένα πάνελ στο οποίο 

γίνονται οι ρυθμίσεις. 
Μερικές από τις ρυθμίσεις που υπάρχουν στο πάνελ, είναι: 
Format: με το οποίο επιλέγεται η κωδικοποίηση της ταινίας, την οποία πρόκειται 
να εξάγετε. Αναλυτικότερα, οι κωδικοποιήσεις αυτές, φαίνονται στην εικόνα 63. 
Preset: όπου υπάρχουν προεπιλεγμένες κατηγορίες σχετικά με το τηλεοπτικό 
σύστημα που θα χρησιμοποιηθεί για την ταινία που θα εξάγετε και επιλέγετε 
μεταξύ αυτών (εικόνα 64). 
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ΕΙΚΟΝΑ 63 

 

 
ΕΙΚΟΝΑ 64 

 

Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο:  Μία ταινία που την έχετε αποθηκεύσει από προηγούμενες 
δραστηριότητες, αποθηκεύστε την σε μορφή PAL. 
Βήμα 2ο: Από την ταινία του 1ου βήματος, αποθηκεύστε μόνο την εικόνα χωρίς 
ήχο. 
Βήμα 3ο:  Από την ταινία του 1ου βήματος, αποθηκεύστε μόνο τον ήχο χωρίς 
εικόνα. 
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Σεμινάριο για τον τομέα Ηλεκτρονικής των ΕΠΑΛ 
 
 

Μέρος 2ο 

 
Θέμα: Προγραμματισμός με την βοήθεια της Visual 

Basic 
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1. Γενικά 
 
Το σεμινάριο αφορά την αξιοποίηση του λογισμικού Adobe Premier Pro CS3καθώς 
και του διαδικτύου στην τεχνική και επαγγελματική εκπαίδευση, και συγκεκριμένα, 
στη διδασκαλία του μαθήματος «ΕΦΑΡΜΟΓΕΣ ΠΡΟΓΡΑΜΜΑΤΙΣΜΟΥ ΓΙΑ 
ΗΛΕΚΤΡΟΝΙΚΟΥΣ» της ειδικότητας «Ηλεκτρονικών Συστημάτων Επικοινωνιών»  
και της ειδικότητας «Ηλεκτρονικών Υπολογιστικών Συστημάτων & ∆ικτύων» του 
τομέα Ηλεκτρονικής.  
Οι επιμορφούμενοι χωρίζονται σε μικρές ομάδες, κάθε μία από τις οποίες 
αντιπροσωπεύει τα μέλη της υποτιθέμενης εταιρίας. Ο επιμορφωτής αναλαμβάνει 
ρόλο συντονιστή του έργου. 
Οι πρώτες δραστηριότητες αφορούν τη γνωριμία με το λογισμικό και τις βασικές 
αρχές λειτουργίας του καθώς επίσης και την οργάνωση της εργασίας στον 
υπολογιστή.  
Οι επιμορφούμενοι καλούνται να μάθουν τις δυνατότητες και τον χειρισμό του 
λογισμικού Visual Basic καθώς και να δημιουργήσουν μία δική τους ταινία με την 
βοήθεια των δυνατοτήτων του Visual Basic.   
Στις επόμενες ενότητες δίνεται η δυνατότητα να κάνουν προγράμματα με την 
γλώσσα προγραμματισμού Visual Basic. 
 

2. Ένταξη Σεμιναρίου στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 
Ηλεκτρονικών Υπολογιστικών Συστημάτων & ∆ικτύων 

Μάθημα: Εφαρμογές Προγραμματισμού για Ηλεκτρονικούς 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 

∆ιδακτικές ώρες: 9 

 

3. Περιγραφή επιμορφωτικού σεναρίου 
 
Οι επιμορφούμενοι χωρίζονται σε ομάδες των τριών ατόμων και ο καθένας 
αναλαμβάνει ένα συγκεκριμένο ρόλο ανάλογα με την εξοικείωσή του στη χρήση 
του υπολογιστή και του λειτουργικού συστήματος WINDOWS, του δικτύου και του 
λογισμικού Visual Basic. Στην συνέχεια όμως αφού και οι υπόλοιποι εξοικειωθούν 
με τα παραπάνω λειτουργικά συστήματα, αλλάζουν ρόλους σε κάθε 
δραστηριότητα.  
 

Το σενάριο έχει σχεδιαστεί με τέτοιο τρόπο ώστε να κινητοποιεί όλους τους 
επιμορφούμενους να αντιμετωπίσουν όλα τα απαιτούμενα στάδια, προκειμένου να 
καταλήξουν στην διαμόρφωση του τελικού προϊόντος που θα είναι η δημιουργία 
μίας ταινίας με τίτλους, υπότιτλους και διάφορα οπτικά και ακουστικά εφέ. 
Κατανέμονται ρόλοι ανάλογα με το δυναμικό του κάθε επιμορφούμενου για να 
αποσαφηνίζονται έννοιες και να υιοθετούνται πρακτικές μεταξύ των μελών των 
ομάδων, αλλά και μεταξύ των ομάδων και του επιμορφωτή, ώστε οι 
επιμορφούμενοι να γίνονται ικανοί να λύνουν τα προβλήματα που παρουσιάζονται. 
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Τα μέλη της ομάδας προγραμματίσουν κάποιο μικρό «παιχνίδι».  
 

Η επιλογή του θέματος του επιμορφωτικού σεναρίου έχει σαν σκοπό τη σύνδεση 
του μαθήματος «Εφαρμογές Προγραμματισμού για Ηλεκτρονικούς» με την 
επαγγελματική πράξη διότι το αντικείμενο του μαθήματος αφορά θέματα που 
πλέον χειρίζονται ευκολότερα και με μεγαλύτερη ακρίβεια με τη βοήθεια Η/Υ και 
κατάλληλων λογισμικών. 

 

Η θεωρητική στήριξη του σεναρίου βασίζεται κυρίως στο πλαίσιο της 
εμπλαισιωμένης μάθησης (situated learning), μέσω της ανάπτυξης κοινοτήτων 
πρακτικής (community of practice), οι οποίες δημιουργούν τις προϋποθέσεις για 
ένα αυθεντικό πλαίσιο μάθησης, ενώ ταυτόχρονα μπορούν να αξιοποιούν την 
εμπειρία των εκπαιδευομένων (αρχαρίων και ειδικών), όταν αυτοί κινούνται από 
την περιφέρεια προς το κέντρο δηλ. το μαθησιακό στόχο (legitimate peripheral 
participation). 

 
4. ∆ιδακτικοί Στόχοι 
 

Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας του σεναρίου ο 
επιμορφούμενος αναμένεται: 
 Να εξοικειωθεί με τις εντολές της Visual Basic. 
 Να καταλάβει την φιλοσοφία του λογισμικού Visual Basic. 
 Να γνωρίσει τις εντολές και τα εργαλεία της Visual Basic. 
 Να δημιουργεί προγράμματα. 
 Να επιλέγει τον αποτελεσματικότερο τρόπο γι’ αυτό. 
 Να αναζητά, να επεξεργάζεται και να αποστέλλει ηλεκτρονικά αρχεία. 
 Να συνεργάζεται με άλλους για τη δημιουργία πολύπλοκων παρεμβάσεων στην 
διαμόρφωση μιας ταινίας. 

 Να εκμεταλλεύεται τη δυνατότητα που δίνει το διαδίκτυο στην πρόσβαση σε 
θέματα ειδικού ενδιαφέροντος και την συνεχή και άμεση ενημέρωση. 

 

5. Απαραίτητοι Τεχνολογικοί Πόροι 
 
 Εργαστηριακοί χώροι 

Το εργαστήριο πληροφορικής του σχολείου  
 ∆ιαδικτυακή υποδομή 

Τοπικό δίκτυο και σύνδεση στο Internet.  
 Υλικό (Hardware) 

Υπολογιστές, ένας server και μία κάμερα λήψης εικόνας. 
 Λογισμικά Εργαλεία (Software) 

Tο λογισμικό Visual Basic, ένας browser (π.χ. Internet Explorer) και άλλες 
εφαρμογές όπως Acrobat Reader, Word. 
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6. Αναλυτική Περιγραφή ∆ραστηριοτήτων 
 
Το εκπαιδευτικό σεμινάριο αποτελείται από τρεις δραστηριότητες. Το θέμα και η 
διάρκεια κάθε μαθήματος παρουσιάζονται στον παρακάτω πίνακα. Οι 
δραστηριότητες αποτελούν το εκπαιδευτικό σενάριο. Εκτενέστερη αναφορά στην 
περιγραφή και στους στόχους των δραστηριοτήτων γίνεται στο αναλυτικό 
πρόγραμμα του σεμιναρίου. 
 
Αρ. ∆ιάρκεια 

(ώρες) 
Θέμα 

1 3 ∆υνατότητες του Adobe Premier Pro CS3 – η φιλοσοφία του 

2 3 Ξενάγηση στο περιβάλλον του Adobe Premier Pro CS3 

3 3 ∆ημιουργία νέας ταινίας - Εισαγωγή δεδομένων 

 
Κάθε δραστηριότητα του επιμορφωτικού σεναρίου πραγματοποιείται ύστερα από 
την ολοκλήρωση της αμέσως προηγούμενης.  
 

Θα δοθούν σε ηλεκτρονική μορφή πίνακες με τις εργαλειοθήκες του λογισμικού 
(αρχείο PDF ή WORD)  

 

7. Περιγραφή ρόλων συμμετεχόντων 
 
Στην πραγματοποίηση των δραστηριοτήτων οι επιμορφούμενοι έχουν 
συγκεκριμένους ρόλους: 
 
Ρόλος επιμορφούμενου 
Οι επιμορφούμενοι χωρίζονται σε ομάδες των τριών ατόμων. Όλοι σχεδιάζουν και 
εκτελούν τις εργασίες και δραστηριότητες κάθε ενότητας του σεμιναρίου. Στα 
πλαίσια της ομάδας, είναι δυνατό κάθε επιμορφούμενος να σχεδιάσει τμήμα του 
σχεδίου, ύστερα από συνεννόηση με την ομάδα του. Τέλος παραδίδει την εργασία 
του στον εκπρόσωπο της ομάδας του είτε ηλεκτρονικά μέσω email είτε 
αποθηκεύοντας την σε ένα κοινό φάκελο που έχουν δημιουργήσει στο τοπικό 
δίκτυο σαν ομάδα. 
 

Οι εκπαιδευτικές θεωρίες για τη συνεργατική μάθηση προτείνουν ότι μια ομάδα 
πρέπει να αποτελείται από μονό αριθμό μελών με καταλληλότερους τους αριθμούς 
τρία και πέντε. 

 
Ρόλος ομάδας επιμορφούμενων 
Κάθε ομάδα αντιπροσωπεύει το studio ενός τηλεοπτικού καναλιού από το οποίο 
ζητείται να δώσει μονταρισμένα πλάνα μιας εκπομπής.   
Για το τελικό προϊόν, η ομάδα πρέπει να εκτελέσει επιμέρους επεμβάσεις στην 
ταινία και να προσθέσει τίτλους και υπότιτλους αν χρειαστεί.  
Η κάθε ομάδα (ή ο επιμορφούμενος) αποθηκεύει τα προσωπικά της αρχεία σε δικό 
της φάκελο και τα  υποβάλλει ηλεκτρονικά μέσω email ή τα αντιγράφει σε ένα 
DVD και το παραδίδει. 
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Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν μία ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους. 
 
Επιμορφούμενος  Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό της Visual 
Basic. 
Κατά τη διαδικασία της ηλεκτρονικής συνάρμοσης εικόνας, είναι υπεύθυνος για την 
σωστή και ακριβή εκτέλεση των παρεμβάσεων της ομάδας. Αναλαμβάνει επίσης να 
βοηθήσει τα άλλα μέλη της ομάδας αν έχουν δυσκολίες στην ηλεκτρονική 
συνάρμοση.  
 

Ο επιμορφούμενος Α, έχει αυξημένες αρμοδιότητες σε σχέση με τα υπόλοιπα μέλη, 
ώστε να μπορεί να δώσει λύσεις σε τυχόν προβλήματα που προκύπτουν μέσα στην 
ομάδα. Επίσης συντονίζει συζήτηση μέσα στην ομάδα, για να εξασφαλίσει την 
ποιότητα της εργασίας. Στην πορεία βέβαια όλοι οι επιμορφούμενοι θα 
κληθούν να πάρουν την θέση αυτή καθώς όλοι πρέπει να περάσουν από 
όλες τις θέσεις.  

 
Επιμορφούμενος Β: 2ος Μελετητής  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό του δικτύου 
και του internet. Αναλαμβάνει την ηλεκτρονική αποστολή της εργασίας της ομάδας 
στον επιμορφωτή μέσω e-mail καθώς και την εκτύπωση της. 
 
Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
Λογισμικά: Visual Basic, Microsoft Word, Αcrobat, Πρόγραμμα ηλεκτρονικού 
ταχυδρομείου (Outlook Express, Mozilla Thunderbird) 
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8. ∆ραστηριότητες 
 
∆ραστηριότητα 1η:   
∆ημιουργία διασύνδεσης χρήστη και ορισμός των ιδιοτήτων 

 
α. Γενικά 
 
Η δραστηριότητα αφορά τον τρόπο με τον οποίο γίνεται η φόρμα ενός 
προγράμματος στην Visual Basic. 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 
Ηλεκτρονικών Υπολογιστικών Συστημάτων & ∆ικτύων 

Μάθημα: Εφαρμογές Προγραμματισμού για Ηλεκτρονικούς 

∆ιδακτικές ενότητες: ∆ημιουργία διασύνδεσης χρήστη και ορισμός των ιδιοτήτων 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να γνωρίζει τον τρόπο δημιουργίας μιας φόρμας στην Visual Basic. 
 Να εισάγει κουμπιά (Buttons), ετικέτες (Labels) και φωτογραφίες μέσα στην 
φόρμα. 

 Να ορίζει τις ιδιότητες των παραπάνω αντικειμένων. 
 Να γνωρίσει την περιοχή εντολών της Visual Basic. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 
 
Ρόλος ομάδας επιμορφούμενων 
Στην εισαγωγική αυτή δραστηριότητα γίνεται η γνωριμία των μελών των ομάδων 
μεταξύ τους. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό της Visual 
Basic 2008. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
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Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
 
Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
Λογισμικά: Visual Basic 2008, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
Ξεκινήστε την Visual Basic και από το μενού File επιλέξτε την εντολή New Project. 
Τότε θα ανοίξει το πλαίσιο διαλόγου της εικόνας 65 και θα επιλέξετε το εικονίδιο 
Windows Forms Application. 
 

 
ΕΙΚΟΝΑ 65 

Στο κάτω μέρος του πλαισίου, θα δηλώσετε το όνομα του αρχείου που πρόκειται 
να δημιουργήσετε. Πατώντας το ΟΚ, θα ανοίξει το παράθυρο εργασίας της Visual 
Basic. 
 
Ανοίγει το παράθυρο εργασίας της Visual Basic (εικόνα 66). Όπως παρατηρείται, 
εσωτερικά έχει ένα πλαίσιο, το μέγεθος του οποίου είναι μικρό. Αν θέλετε να το 
μεγαλώσετε, πλησιάζετε τον κέρσορα στην κάτω δεξιά γωνία και όταν αυτός πάρει 
το σχήμα διπλού βέλος (δείκτης αλλαγής μεγέθους), τότε θα κρατήσετε το 
αριστερό κλικ πατημένο και θα το σύρετε, ώστε να μεγαλώσει το πλαίσιο. 
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ΕΙΚΟΝΑ 66 

 
Στο επάνω μέρος της οθόνης βρίσκεται η γραμμή εντολών και η γραμμή 
εργαλείων. Τα εργαλεία που απαρτίζουν την γραμμή εργαλείων, απεικονίζονται 
στην εικόνα 67. 

 
ΕΙΚΟΝΑ 67 

 



85 

 

Εκτός αυτών, απεικονίζεται και η εργαλειοθήκη, η οποία μπορεί και να κρυφτεί, 
όταν δεν χρειάζεται. Η εργαλειοθήκη εμφανίζεται, όταν από την γραμμή εργαλείων 
επιλέξετε την εντολή «Toolbox». Από την εργαλειοθήκη επιλέγετε τα εργαλεία που 
θα χρησιμοποιήσετε για την δημιουργία της φόρμας. 
 
Εισαγωγή Button στην φόρμα 
Από την εργαλειοθήκη επιλέγετε το εργαλείο Button, κάνοντας διπλό αριστερό 
κλικ πάνω σε αυτό. Το λογισμικό δημιουργεί ένα αντικείμενο στην φόρμα, το οποίο 
το ονομάζει «Button 1» (εικόνα 68). Πηγαίνοντας τον κέρσορα πάνω στο Button, 
θα δείτε ότι παίρνει το σχήμα σταυρού με βελάκια στις άκρες του. Σύρετε το 
Button μέσα στην φόρμα κρατώντας το αριστερό κλικ του ποντικού πατημένο. 
 

 
ΕΙΚΟΝΑ 68 

 
Επαναλαμβάνετε την παραπάνω διαδικασία, οπότε μπαίνει και ένα δεύτερο Button 
στην φόρμα, το οποίο φέρει την ονομασία «Button 2». Αν θελήσετε να βάλετε και 
άλλα, τότε το καθένα από αυτά θα έχει και διαφορετικό νούμερο. 
Αν σύρετε το πρώτο Button σε μια θέση κάτω από το προηγούμενο, θα δείτε ότι 
στο ένα κάθετο άκρο του σχηματίζεται μια ευθεία κάθετη γραμμή, που σας βοηθάει 
να τα ευθυγραμμίσετε μεταξύ τους. 
 
Εισαγωγή Label στην φόρμα 
Πατήστε το εργαλείο «Label», στην εργαλειοθήκη και θα εμφανιστεί ένα πλαίσιο 
που ονομάζεται «1». Αυτό να το σύρετε και να το τοποθετήσετε δεξιά από το  
«Button 1». Τότε στο ένα οριζόντιο άκρο του, θα εμφανιστεί μία ευθεία οριζόντια 
γραμμή, που σας βοηθάει να τα ευθυγραμμίσετε μεταξύ τους. 
Επαναλαμβάνετε τις παραπάνω κινήσεις, εισάγοντας άλλες τρεις ταμπέλες, εκ των 
οποίων οι δύο θα τοποθετηθούν δεξιά από την προηγούμενη και η τέταρτη θα πάει 
κάτω από το «Button 2». Και σε αυτή την περίπτωση θα βγουν οι ευθείες γραμμές 
για την στοίχιση τους. 
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Εισαγωγή εικόνας στην φόρμα 
Αν πατήσετε το εργαλείο PictureBox από την εργαλειοθήκη, τότε θα εμφανιστεί το 
περίγραμμα μιας εικόνας. Αυτό δεν έχει όνομα πάνω στη φόρμα, όπως τα δύο 
προηγούμενα, αλλά στον προγραμματισμό θα αναγνωρίζεται σαν «PictureBox 1». 
Στην συνέχεια, μεγεθύνετε τα πλαίσια του περιγράμματος, όπως κάνατε και με τα 
προηγούμενα. Απλώνετε τα αντικείμενα μέσα στον χώρο της φόρμας, για να 
πάρουν την τελική τους θέση.  
 
Ορισμός των ιδιοτήτων των αντικειμένων 
Επιλέξτε τα αντικείμενα της φόρμας και ορίστε τις ιδιότητές τους. Οι τροποποιήσεις 
αυτές γίνονται με την βοήθεια του παραθύρου ιδιοτήτων «Properties window)». 
 
Ρυθμίσεις κουμπιών 
Για την ρύθμιση του Button 1, επιλέγετε το κουμπί και στην συνέχεια πάτε στο 
παράθυρο Properties και πατάτε το κουμπί «Categorized», όπως φαίνεται στην 
εικόνα 69. 
 

 
ΕΙΚΟΝΑ 69 

 
Στην κατηγορία Appearance, επιλέγετε την εντολή text με διπλό κλικ. Στη 
συνέχεια πάτε στην ένδειξη του text που είναι Button 1 και πληκτρολογείτε την 
λέξη «Spin» και πατήστε Enter. Παρατηρείτε ότι το όνομα αλλάζει μόνο στο κουμπί 
της φόρμας. 
Επαναλάβετε το ίδιο και για το Button 2, αλλά θα το ονομάσετε End. 
 
Ρύθμιση ετικετών 
Οι ρυθμίσεις που θα γίνουν σε κάθε ετικέτα έχουν σχέση με την μορφή των 
γραμμάτων το μέγεθος του πλαισίου της ετικέτας. Όλες οι ρυθμίσεις γίνονται από 
το παράθυρο των ιδιοτήτων (Properties). 
Επιλέξτε την πρώτες τρεις ετικέτες (Label 1, Label 2 και Label 3) και πηγαίνετε 
στην κατηγορία Layout, όπου επιλέγετε την εντολή AutoSize. Πατάτε το βέλος που 
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βρίσκεται δεξιά και επιλέγετε False. Αυτό έχει σαν αποτέλεσμα να μην επιλέγεται 
αυτόματα το μέγεθος της ετικέτας, αλλά να το ρυθμίζετε εσείς. 
 

 
ΕΙΚΟΝΑ 70 

 
Στη συνέχεια επιλέγετε την εντολή TextAlign, πατάτε το βέλος που βρίσκεται δεξιά 
και βλέπετε ότι εμφανίζεται μια σειρά από επιλογές για την θέση των γραμμάτων 
στο πλαίσιο. Επιλέγετε την μεσαία θέση (MiddleCenter). 
Επιλέγετε BorderStyle και πατάτε το βέλος που βρίσκεται δεξιά, όπου επιλέγετε 
την εντολή FixedSingle, η οποία προσθέτει ένα λεπτό περίγραμμα γύρο από το 
περίγραμμα.  
Επιλέγετε Font και πηγαίνετε στο τετράγωνο με τις τρεις τελείες που βρίσκεται στα 
δεξιά, κάνοντας κλικ πάνω σε αυτό. Με αυτή την επιλογή, έχετε όλες τις ρυθμίσεις 
των γραμματοσειρών. Η γραμματοσειρά θα είναι Arial, έντονα μεγέθους 24. 
Επιλέγετε μόνο την πρώτη ετικέτα, κάνετε διπλό κλικ στην εντολή  Text και 
γράψτε 0. κάνετε το ίδιο και για τις ετικέτες 2 και 3. Στη συνέχεια μετακινείτε τις 
ετικέτες και αλλάζετε το μέγεθός τους, ώστε να απέχουν το ίδιο και να χωράει το 0 
μέσα τους. 
 
Η άλλη ετικέτα (Label 4) ρυθμίζετε ως εξής: 
 Στο Text επιλέγετε να γράψετε «Lucky Seven» 
 Στο Font επιλέγετε Arial, έντονη γραφή, 18 μέγεθος. 
 Στο AutoSize επιλέγετε True, οπότε το μέγεθος του πλαισίου προσαρμόζετε στο 
περιεχόμενο. 

 Οι υπόλοιπες ρυθμίσεις γίνονται όπως και στις προηγούμενες ετικέτες. 
 
Επιλέγετε την ιδιότητα ForeColor και πατάτε το βέλος, οπότε εμφανίζεται μια 
παλέτα χρωμάτων, όπως βλέπετε στην εικόνα 71. επιλέγετε το βαθύ κόκκινο 
χρώμα. Βλέπετε ότι όλα τα γράμματα πήραν αυτό το χρώμα. 
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ΕΙΚΟΝΑ 71 

 
Εισαγωγή της εικόνας 
Η σειρά που ακολουθείται για την εισαγωγή της εικόνας είναι: 
Πατάτε το πλαίσιο εικόνας 
 Επιλέγετε την ιδιότητα SizeMode, πατάτε το βέλος και επιλέγετε StretchImage. 
Αυτή η ενέργεια γίνεται πριν την είσοδο της εικόνας, για την καλύτερη 
προσαρμογή της στο πλαίσιο που υπάρχει. 

 
ΕΙΚΟΝΑ 72 

 
 Επιλέγετε την ιδιότητα Image και πηγαίνετε στο τετράγωνο με τις τρεις τελείες 
που βρίσκεται στα δεξιά, κάνοντας κλικ πάνω σε αυτό. Ανοίγει το παράθυρο 
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διαλόγου (Select Resource), απ’ όπου επιλέγετε το Local Resource και πατάτε 
την εντολή Import. 

 Πηγαίνετε στον φάκελο που είναι το αρχείο της εικόνας, επιλέγετε την εικόνα 
και πατάτε Open. 

 Η φωτογραφία εμφανίζεται στην φόρμα. 
Για να μην εμφανίζεται πάντοτε η εικόνα, αλλά να εμφανίζετε μόνο όταν το 
επιλέξετε, επιλέγετε την ιδιότητα Visible και πατάτε την ρύθμιση False. 
 

 
ΕΙΚΟΝΑ 73 

 
 
Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο:  ∆ημιουργήστε μια δική σας φόρμα με τέσσερις αριθμούς. 
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∆ραστηριότητα 2η:   
Συγγραφή του κώδικα 

 
 
α. Γενικά 
 
Η δραστηριότητα αφορά τον τρόπο με τον οποίο γράφεται ο κώδικας για την 
φόρμα της προηγούμενης δραστηριότητας. 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 
Ηλεκτρονικών Υπολογιστικών Συστημάτων & ∆ικτύων 

Μάθημα: Εφαρμογές Προγραμματισμού για Ηλεκτρονικούς 

∆ιδακτικές ενότητες: Συγγραφή του κώδικα 

∆ιδακτικές ώρες: 3 

 
γ. ∆ιδακτικοί Στόχοι 
 
Σαν αποτέλεσμα της εκπαιδευτικής διαδικασίας ο επιμορφούμενος αναμένεται: 
 Να γνωρίζει να γράφει τον κώδικα για μια φόρμα στην Visual Basic. 
 Να γνωρίσει την περιοχή εντολών της Visual Basic. 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 
 
Ρόλος ομάδας επιμορφούμενων 
Στην εισαγωγική αυτή δραστηριότητα γίνεται η γνωριμία των μελών των ομάδων 
μεταξύ τους. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό της Visual 
Basic 2008. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
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Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
Λογισμικά: Visual Basic 2008, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
Κάνετε διπλό κλικ στο «End», οπότε εμφανίζεται το παράθυρο επεξεργαστή κώδικα 
(εικόνα 74), όπου εμφανίζονται οι εντολές που σχετίζονται με την φόρμα. 
 

 
ΕΙΚΟΝΑ 74 

 
Με την ενέργεια αυτή που κάνατε, το Visual Studio πρόσθεσε αυτόματα την πρώτη 
και την τελευταία γραμμή του κώδικα. Για τις υπόλοιπες ενέργειες θα 
δημιουργήσετε υπορουτίνες ανάμεσα από αυτές. 
Για να γράψετε την εντολή για το «Spin», αρκεί να πάτε στη γραμμή εντολών και 
να επιλέξετε: 

View > Designer 
Οπότε θα εμφανιστεί ξανά η φόρμα.  
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Κάνετε διπλό κλικ πάνω στο «Spin» και ενημερώνετε τον κώδικα για τις εντολές 
του κουμπιού αυτού. Με αυτό τρόπο οι εντολές εισέρχονται στον κώδικα, όπως 
βλέπετε στην εικόνα 75 
 

 
ΕΙΚΟΝΑ 75 

 
Μέχρι τώρα έχετε τις εντολές για τα δύο κουμπιά. Θα πρέπει να γράψετε τον 
κώδικα για τις ετικέτες και την εικόνα υπό μορφή υπορουτίνας. για τον λόγο αυτό 
θα γράψετε τις παρακάτω εντολές. 
 

PictureBox1.Visible = False      'απόκρυψη εικόνας 
        Label1.Text = CStr(Int(Rnd() * 10))     'επιλογή αριθμών 
        Label2.Text = CStr(Int(Rnd() * 10)) 
        Label3.Text = CStr(Int(Rnd() * 10)) 
        'αν οποιοσδήποτε αριθμός είναι 7, εμφάνιση της εικόνας και 
        'αναπαραγωγή του ήχου 
        If (Label1.Text = "7") Or (Label2.Text = "7") Or (Label3.Text = "7") Then 
            PictureBox1.Visible = True 
            Beep() 
        End If 
Οι εντολές αυτές θα μπουν υπό μορφή υπορουτίνας ανάμεσα στο: 
 
Private Sub 
 . 
 . 
 . 
End Sub 
 

Επομένως, ο κώδικας μετά την ολοκλήρωσή του θα έχει την μορφή που 
απεικονίζεται στην εικόνα 76 
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ΕΙΚΟΝΑ 76 

 
Εκτέλεση του προγράμματος 
Το πρόγραμμα μπορείτε να το ανακαλέσετε με έναν από τους παρακάτω τρόπος, 
μέσα από το περιβάλλον ανάπτυξης. 
 Από την γραμμή εντολών επιλέγετε: 

Debug > Start Debugging 
 Από την βασική γραμμή εργαλείων να πατήσετε το κουμπί «Start Debugging» 

(εικόνα 74). 
 Να πατήσετε το πλήκτρο F5. 
 
Η εικόνα θα εμφανίζεται μόνο αν υπάρχει ο αριθμός 7 σε κάποιο τετράγωνο 
(εικόνα 77). 
 

 
ΕΙΚΟΝΑ 77 
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Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο:  Γράψτε τον κώδικα για το πρόγραμμα της εφαρμογής της 
δραστηριότητας 1. 
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∆ραστηριότητα 3η:   
Μεταβλητές και Συναρτήσεις της Visual Basic 

 
α. Γενικά 
 
Η δραστηριότητα αφορά την εκμάθηση διαφόρων εντολών της Visual Basic. 

 
β. Ένταξη ∆ραστηριότητας στο Αναλυτικό Πρόγραμμα Σπουδών 
 

Τάξη: Γ΄ Τάξη Επαγγελματικών Λυκείων (ΕΠΑ.Λ.) 

Τομέας: Ηλεκτρονικής 

Ειδικότητα: Ηλεκτρονικών Συστημάτων Επικοινωνιών 
Ηλεκτρονικών Υπολογιστικών Συστημάτων & ∆ικτύων 

Μάθημα: Εφαρμογές Προγραμματισμού για Ηλεκτρονικούς 

∆ιδακτικές ενότητες: Μεταβλητές και Συναρτήσεις της Visual Basic 

∆ιδακτικές ώρες: 3 

 
 
δ. Αναλυτική Περιγραφή ∆ραστηριοτήτων 
 
Ρόλος ομάδας επιμορφούμενων 
Οι επιμορφούμενοι εξοικειώνονται με τις μεταβλητές και της συναρτήσεις της  
Visual Basic. 
 
Ρόλος μελών κάθε ομάδας 
Οι επιμορφούμενοι που αποτελούν την ομάδα αναλαμβάνουν συγκεκριμένους 
ρόλους 
 
Επιμορφούμενος Α: 1ος Μελετητής - Εκπρόσωπος ομάδας  
Είναι ο επιμορφούμενος που έχει τη μεγαλύτερη ευχέρεια στο χειρισμό της Visual 
Basic 2008. 
Αναλαμβάνει να βοηθήσει τα άλλα μέλη της ομάδας στην κατανόηση των βασικών 
αρχών λειτουργίας του λογισμικού.  
 
Επιμορφούμενος Β: 2ος Μελετητής  
Στην παρούσα δραστηριότητα δεν έχει κάποια ειδική αρμοδιότητα. 
 
Επιμορφούμενος Γ: 3ος Μελετητής 
∆εν έχει κάποια ειδική αρμοδιότητα. 
 
Κάθε επιμορφούμενος έχει στη διάθεσή του τα εξής: 
 Έναν υπολογιστή με πρόσβαση στο τοπικό δίκτυο και στο διαδίκτυο. 
 Έναν λογαριασμό ηλεκτρονικού ταχυδρομείου. 
 Έντυπα με οδηγίες για την επεξεργασία των εικόνων. 
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Λογισμικά: Visual Basic 2008, Microsoft Word, Outlook Express. 
 
Στάδιο 1ο:  Προετοιμασία 
Ο επιμορφωτής κάνει μια εισαγωγή στη δραστηριότητα, αποσαφηνίζοντας τους 
διδακτικούς της στόχους. ∆ίνονται στους επιμορφούμενους προφορικές οδηγίες, 
στις οποίες αναλύεται ο ρόλος του κάθε επιμορφούμενου καθώς και ο γενικότερος 
σκοπός της δραστηριότητας.  
 
Στάδιο 2ο:  Παρουσίαση 
 
Μεταβλητές στην Visual Basic 
Συμβαίνει συχνά κατά την συγγραφή προγραμμάτων, να προκύπτει η ανάγκη 
παράστασης με συμβολικό τρόπο διαφόρων μεγεθών των οποίων οι τιμές 
μεταβάλλονται κατά την διάρκεια εκτέλεσης των προγραμμάτων. Η συμβολική 
παράσταση γίνεται με λέξεις που ονομάζονται μεταβλητές (Variables).  
 Για κάθε μεταβλητή ο υπολογιστής δεσμεύει ένα τμήμα της κεντρικής μνήμης του, 
στο οποίο καταχωρείται η τιμή που δίνεται στην μεταβλητή από τις εντολές του 
προγράμματος. 
Κανόνες ονομασίας μεταβλητών  (και σταθερών) 
 Το όνομα δεν πρέπει να συμπίπτει με δεσμευμένες λέξεις (keywords), δηλ. 
λέξεις που έχουν κάποιο ιδιαίτερο νόημα για την Visual Basic. (π.χ. False, If, 
Case κλπ) 

 Τα ονόματα πρέπει να αρχίζουν με γράμμα. 
 Τα ονόματα αποτελούνται από γράμματα, αριθμούς και χαρακτήρες 
υπογράμμισης ( _ ). ∆εν επιτρέπονται άλλα σύμβολα (πχ σύμβολα στίξης, 
παρενθέσεις κλπ) ή κενά μέσα στα ονόματα. 

 Τα ονόματα δεν πρέπει να έχουν περισσότερους από 255 χαρακτήρες. 
 Γενικά τα ονόματα πρέπει να είναι μικρά αλλά και να θυμίζουν αυτό που 
αντιπροσωπεύουν. 

 Τα ονόματα μεταβλητών μπορούν να περιέχουν και ελληνικούς χαρακτήρες.    
 

Τύποι μεταβλητών 
Η ίδια διάκριση που συναντήσαμε στις σταθερές, υπάρχει και στις μεταβλητές. 
∆ηλαδή και οι μεταβλητές διακρίνονται σε: 
 Αριθμητικές μεταβλητές. 
 Λογικές μεταβλητές (ή δίτιμες). 
 Αλφαριθμητικές μεταβλητές ή μεταβλητές συμβολοσειρών.   
 Μεταβλητές ημερομηνιών. 
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ΠΙΝΑΚΑΣ ΤΥΠΩΝ ΜΕΤΑΒΛΗΤΩΝ  
και απαιτούμενης μνήμης και περιοχών τιμών 

Τύποι δεδομένων Μνήμη Αποδεκτές τιμές 

Byte  
(μικρός ακέραιος) 

1 byte Ακέραιοι από 0 έως 255 

Boolean 2 bytes True ή False 

Integer 2 bytes Ακέραιοι από –32.768 έως 32.768 

Long  
(μεγάλος ακέραιος) 

4 bytes Ακέραιοι από –2.147.483.648  
                 έως   2.147.483.648  

Currency  
(νόμισμα) 

8 bytes Από –922.337.203.685.477,5808 
έως    922.337.203.685.477,5807   

Single  
(απλής ακρίβειας) 

4 bytes Το 0 και πραγματικοί με απόλυτη τιμή 
μεταξύ  

1,401298 x 10-45 και 3,402823 x 1038 

Double  
(διπλής ακρίβειας) 

8 bytes Το 0 και πραγματικοί με απόλυτη τιμή 
μεταξύ 4,94065645841247 x 10-324 έως 

1,79769313486232 x 10308 

Date 8 bytes Από 1η Ιανουαρίου 100 έως 
 31η ∆εκεμβρίου 9999 

String 
(Μεταβλητού 
μεγέθους) 

10 bytes + 
Πλήθος 

χαρακτήρων 

Από 0 έως 2.000.000.000 χαρακτήρες 
περίπου 

String 
(Σταθερού 
μεγέθους) 

Πλήθος 
χαρακτήρων 

Από 1 χαρακτήρα έως 65.400 χαρακτήρες 
περίπου 

Variant 
(με αριθμούς) 

16 bytes Κάθε αριθμητική τιμή που μπορεί να δεχτεί 
ο τύπος Double 

Variant 
(με χαρακτήρες) 

22 bytes + 
Πλήθος 

χαρακτήρων 

Κάθε συμβολοσειρά που μπορεί να δεχτεί ο 
τύπος String μεταβλ. μεγέθους 

 
∆ήλωση μεταβλητής και επιλογή τύπου 
 Πριν γραφτεί το όνομα μιας μεταβλητής σε ένα πρόγραμμα, καλό είναι να 
δηλωθεί η μεταβλητή και ο τύπος της, ώστε να δεσμευτεί ο κατάλληλος χώρος 
στη μνήμη και να προετοιμαστεί η Visual Basic για την χρήση της. 

 Η δήλωση της μεταβλητής γίνεται με μια εντολή, η οποία αρχίζει συνήθως με 
την λέξη Dim και συντάσσεται ως εξής: 

Dim όνομα_μεταβλητής As τύπος 
όπου τύπος ένας από τους τύπους μεταβλητών του προηγούμενου πίνακα 
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 Πρέπει να είμαστε προσεκτικοί στην επιλογή του τύπου της μεταβλητής. Η 
λανθασμένη επιλογή μεταβλητής θα έχει ως αποτέλεσμα την καθυστέρηση στην 
εκτέλεση του προγράμματος και την σπατάλη μνήμης του συστήματος. Σε 
πολλές περιπτώσεις, είναι περισσότερες από μία οι αποδεκτοί από την Visual 
Basic τύποι μεταβλητών. Εδώ πρέπει να γίνει προσπάθεια επιλογής της 
μεταβλητής από υψηλότερη θέση του πίνακα.       

 Αν δεν δηλωθεί ο τύπος μιας μεταβλητής, τότε η Visual Basic την ορίζει ως 
Variant. 

 Για να επιβάλλεται η υποχρεωτική δήλωση κάθε μεταβλητής τότε στο μενού 
επιλέγουμε διαδοχικά Tools  Options  Editor και μαρκάρουμε το check box 
“Require Variable Declarations” 

 
Η εμβέλεια των σταθερών και μεταβλητών 
 Ως εμβέλεια (scope) μιας συμβολικής σταθεράς ή μιας μεταβλητής, ορίζουμε 
την περιοχή του κώδικα μέσα στην οποία μπορεί να χρησιμοποιηθεί η τιμή της.  
Η εμβέλεια καθορίζεται από δύο παράγοντες: 
 Από το σημείο του προγράμματος που θα γίνει η δήλωση της. 
 Από την κωδική λέξη που θα χρησιμοποιηθεί για την δήλωση. 
Έτσι προκύπτουν, ανάλογα με την εμβέλεια τους τρία είδη συμβολικών σταθερών 
και μεταβλητών: 
 Τοπικές (Local) 
 Προγραμματιστικής μονάδας (private) 
 Καθολικές (Public) 
 
Τοπικές σταθερές και μεταβλητές 
 Οι δηλωτικές εντολές σταθερών και μεταβλητών, γράφονται στην αρχή μιας 
υπορουτίνας, πρίν από τις άλλες εντολές της. Έτσι χρησιμοποιούνται μόνο μέσα 
στην υπορουτίνα, γι αυτό και ονομάζονται τοπικές. 

 Η εντολή δήλωσης των τοπικών σταθερών αρχίζει με την κωδική λέξη Const.     
 Η εντολή δήλωσης των τοπικών μεταβλητών αρχίζει με την κωδική λέξη Dim. 
 Σε διαφορετικές υπορουτίνες του ίδιου προγράμματος, μπορούμε να 
χρησιμοποιούμε τοπικές σταθερές ή μεταβλητές με το ίδιο όνομα, αφού η ισχύ 
της καθεμιάς είναι μέσα στην υπορουτίνα της. 

 Η κάθε τοπική μεταβλητή αρχικοποιείται με την έναρξη της υπορουτίνας. Στην 
περίπτωση που δεν θέλουμε να αρχικοποιείται μια μεταβλητή με την έναρξη της 
υπορουτίνας που ανήκει, την δηλώνουμε ως στατική, χρησιμοποιώντας την 
λέξη Static.  

 Κατά την αρχικοποίηση μιας μεταβλητής: 
 Αν αυτή είναι αριθμητική, της αποδίδεται η τιμή 0. 
 Αν αυτή είναι αλφαριθμητική, της αποδίδεται η τιμή“”  
 Αν αυτή είναι λογική, της αποδίδεται η τιμή False. 

 
Σταθερές και μεταβλητές προγραμματιστικής μονάδας 
 Εάν κρίνεται απαραίτητη η χρήση μιας σταθερής ή μεταβλητής σε περισσότερες 
από μια υπορουτίνες μιας προγραμματιστικής μονάδας (βασικής ή φόρμας), τότε 
αυτή πρέπει να δηλωθεί στο τμήμα δηλώσεων της προγραμματιστικής μονάδας. 

 Για την δήλωση των σταθερών, προαιρετικά πριν από την λέξη Const μπορεί να 
τοποθετηθεί η λέξη Private. 
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 Για την δήλωση των μεταβλητών, μπορεί να χρησιμοποιηθεί η γνωστή κωδική 
λέξη Dim, αν και συνηθίζεται αντί αυτής να χρησιμοποιείται η λέξη Private. Οι 
δύο λέξεις σε αυτή την περίπτωση είναι ισοδύναμες.  

 
Πράξεις και παραστάσεις 
Στην Visual Basic μπορούμε να έχουμε πράξεις μεταξύ σταθερών και μεταβλητών 
ίδιου αλλά και διαφορετικού τύπου. 
Οι πράξεις και παραστάσεις που υποστηρίζει η Visual Basic είναι: 
 Αριθμητικές 
 Συμβολοσειρών 
 Ημερομηνίες  

 
Αριθμητικές πράξεις & παραστάσεις 
Οι αριθμητικές πράξεις που μπορεί να εκτελέσει η Visual Basic φαίνονται στον 
πίνακα που ακολουθεί: 

 

Πράξη Σύμβολο 

Πρόσθεση + 

Αφαίρεση - 

Πολλαπλασιασμός * 

∆ιαίρεση / 

Ακέραια διαίρεση \ 

Modulo mod 

Ύψωση σε δύναμη ^ 

 
 

Πράξεις μεταξύ ημερομηνιών 
Η Visual Basic διαχειρίζεται τις ημερομηνίες όπως τους αριθμούς. ∆ηλαδή αν 
αφαιρέσουμε δύο ημερομηνίες θα βρούμε την χρονική τους διαφορά, ή αν 
προσθέσουμε έναν αριθμό σε μια ημερομηνία θα βρούμε μια ημερομηνία κάποιες 
ημέρες μετά.  
 
Σταθερές και μεταβλητές παραστάσεις 
 Οι σταθερές (Constants) είναι αριθμοί ή σύμβολα ή λεκτικά ή ημερομηνίες που 
δεν αλλάζουν κατά την διάρκεια εκτέλεσης ενός προγράμματος. 

 Οι μεταβλητές (Variables), ορίζονται ως ποσότητες που η τιμή τους μπορεί να 
μεταβληθεί από τις εντολές του προγράμματος, με στόχο να αποθηκεύουμε 
προσωρινά κάποιες τιμές, ώστε να χρησιμοποιηθούν σε κάποια άλλα σημεία του 
προγράμματος ή σε επόμενες χρονικές στιγμές. 

 Οι παραστάσεις σχηματίζονται από σύνθεση σταθερών και μεταβλητών που 
συνδέονται μεταξύ τους με πράξεις. 
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Σταθερές (Constans) 
Η Visual Basic διαθέτει τέσσερα είδη σταθερών: 
 Αριθμητικές σταθερές (Numeric constants): Αριθμητικές σταθερές είναι η κάθε 
μορφής αριθμοί. Και εδώ υπάρχει μια διάκριση σε δύο είδη αριθμητικών 
σταθερών 
 Στις ακέραιες (integer)  οι οποίες παριστάνουν ακέραιους αριθμούς και 
 Στις πραγματικές (real) οι οποίες παριστάνουν πραγματικούς αριθμούς.  

 Λογικές σταθερές (Boolean constants): είναι οι True (Αληθές) και False 
(Ψευδές). Είναι κωδικές λέξεις και χρησιμοποιούνται ως συμβολισμοί σταθερών. 
 Χρησιμοποιούνται όπου απαιτείται να ληφθεί απόφαση. 

 Αλφαριθμητικές σταθερές (String constants): Αλφαριθμητικές σταθερές είναι οι 
«λέξεις», οι «φράσεις» και γενικά οι σειρές συμβόλων που αποτελούνται από 
γράμματα, ψηφία και ειδικά σύμβολα. 

 Σταθερές ημερομηνιών (Dates constants): Περικλείονται μεταξύ συμβόλων # 
και ακολουθούν τον αμερικανικό τρόπο συμβολισμού με γενική μορφή:  

#μμ/ηη/εεεε# 
 

Αλφαριθμητικές συναρτήσεις 
Αλφαριθμητικές είναι οι συναρτήσεις που είτε η τιμή τους είναι αλφαριθμητική, είτε 
περιέχουν τουλάχιστον μια αλφαριθμητική ποσότητα. 
Οι αλφαριθμητικές συναρτήσεις στην Visual Basic είναι: 

  

Συνάρτηση Λειτουργία 

Asc(a) Ο κωδικός αριθμός ASCII του πρώτου χαρακτήρα του a 

Chr(x) Ο χαρακτήρας ASCII του αριθμού x 

Insrt(x,a,b) Η θέση του b μέσα στο a, σρχίζοντας από το x 

Lcase(a) Μετατροπή κεφαλαίων σε πεζά 

Len(x) Το πλήθος των χαρακτήρων του x 

Left (a,x) Οι x πρώτοι χαρακτήρες του a 

Ltrim (a) Αφαιρεί τα διαστήματα από την αρχή του a  

Mid (a,x,y) y χαρακτήρες του a αρχίζοντας από τον x-στό 

Right (a,x) Οι x τελευταίοι χαρακτήρες του a 

Rtrim (a) Αφαιρεί τα διαστήματα από το τέλος του a 

Space (x) Η συμβολοσειρά που αποτελείται από x διαστήματα 

String (x,a) Μια συμβολοσειρά από x όμοιους χαρακτήρες  a 

Trim (a) Αφαιρεί τα διαστήματα από την αρχή και το τέλος  

Ucase (a) Μετατροπή πεζών σε κεφαλαία  

Οι παράμετροι a,b δηλώνουν αλφαριθμητικές ποσότητες 
Ενώ οι x,y δηλώνουν αριθμητικές ποσότητες 
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ΜΑΘΗΜΑΤΙΚΕΣ ΣΥΝΑΡΤΗΣΕΙΣ 

ΣΥΝΑΡΤΗΣΗ ΠΑΡΑΣΤΑΣΗ ΛΕΙΤΟΥΡΓΙΑ 

Abs (x) x Απόλυτη τιμή του χ 

Atn (x) τοξεφx Τόξο εφαπτομένης x 

Cos (x) συνx Συνημίτονο x 

Exp (x) ex ∆ύναμη με βάση τον αριθμό e 

Fix (x)   Αποκοπή των ψηφίων μετά την υποδιαστολή 

Int (x) [x] Ακέραιο μέρος του x 

Log (x) lnx Νεπέρειος λογάριθμος του x  

Rnd (x)   Τυχαίος αριθμός από το (0,1) 

Sgn (x)   Πρόσημο του x 

Sin (x) ημx Ημίτονο του x 

Sqr (x) x Τετραγωνική ρίζα του x 

Tan (x) εφx Εφαπτομένη του x 

 
 

Συναρτήσεις ημερομηνιών – ωρών 
Οι συναρτήσεις ημερομηνιών και ώρας είναι μια σημαντική κατηγορία 
συναρτήσεων που εκτελούν πολλούς και πολύπλοκους υπολογισμούς. 
Οι συναρτήσεις ημερομηνιών στην Visual Basic είναι: 

  

Συνάρτηση Λειτουργία 

Date ( ) Τρέχουσα ημερομηνία. 

DateSerial (y,m,d) Ημερομηνία από έτος, μήνα, ημέρα.  

DateValue (v) Μετατροπή σε ημερομηνία. 

Day (d) Ημέρα χρονικής στιγμής. 

Hour (d) Ώρα χρονικής στιγμής. 

Minute (d) Λεπτά χρονικής στιγμής. 

Month (d) Μήνας χρονικής στιγμής. 

Now () Τρέχουσα χρονική στιγμή. 

Second (d) ∆ευτερόλεπτα χρονικής στιγμής. 

Timer Τα δευτερόλεπτα που πέρασαν από τα μεσάνυχτα. 

TimeSerial (h,m,s)  Ώρες από ώρες, λεπτά, δευτερόλεπτα.  

TimeValue (v) Μετατροπή σε ώρα. 

Year (d) Έτος χρονικής στιγμής. 

WeekDay (d) Ημέρα της εβδομάδας. 

IsDate (v) Ελέγχει αν η παράμετρος αποτελεί ημερομηνία. 
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Στάδιο 3ο:  Εφαρμογή  
Βήμα 1ο:  Να κατασκευάσετε πρόγραμμα που θα υπολογίζει την ηλικία σας σε 
ημέρες. 
 
Βήμα 2ο: Στην σχεδίαση της φόρμας θα χρησιμοποιήσετε Frame για τα αντικείμενα 
του αποτελέσματος. Πρώτα θα τοποθετήσετε το Frame και έπειτα τα αντικείμενα 
πάνω σε αυτό. Το Frame δεν θα είναι ορατό με το φόρτωμα της φόρμας (μέσα στο 
Frame θα τοποθετήσετε Label και TextBox αποτελέσματος, συνιστώμενη ονομασία: 
FraResult 
 
Βήμα 3ο:  Στην σχεδίαση της φόρμας θα χρησιμοποιήσετε Timer ο κώδικας του 
οποίου θα ενημερώνει ένα TextBoxt με την τρέχουσα ημερομηνία (συνιστώμενη 
ονομασία: TxtToday). Αυτό το TextBox δεν θα είναι ορατό. 
 
Βήμα 4ο:  Θα κάνετε χρήση της συνάρτησης DateValue για τα περιεχόμενα των 
TextBox, με τα οποία θα γίνει η αφαίρεση 
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